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Symbols and Abbreviations Used

RCT
S-CVI
S-CVI1/Ave
S-CVI/AU

SD

confidence interval

content validity

null hypothesis

working hypothesis

item content validity index

Mean

Mode

Median

P-value (statistical significance)

Randomized controlled trial

scale content validity index

scale-level content validity index based on the average method
scale-level content validity index based on the universal agreement
method

Standard deviation
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1 Data and Quantitative Research

Methods in Nursing

Nurses use and generate a lot of data in their daily work with patients. The main goal
of patient care is to provide high-quality and evidence-based nursing care, so nurses
are obliged to keep up to date with and apply the latest studies and evidence to their
work. It is, therefore, important that nurses have the knowledge and understanding
of data and data analysis techniques, as this is the only way to understand the latest
evidence. Presented here is a short guide that includes basic information on
quantitative research methods and information on statistical tests with which nurses

need to be familiar in their work.

The data used in the book is based on data collected using the Self-Care of Diabetes
Index (SCODI) questionnaire (Ausili, et al., 2017). The data were collected as part
of a pilot study on patients with diabetes in Slovenia. The data are intended for

educational and research purposes only.

There are many hands-on examples included to make the materials more engaging.
We hope you will find this introduction to quantitative data analysis for nurses
useful.
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2 Quantitative Study

The following section describes the basic characteristics of quantitative research
and breaks down the different types of quantitative research. The final part of the
chapter gives a brief overview of how to produce a quantitative research report.

The learning objectives of this chapter are to enable the reader to understand the

basic concepts of quantitative research, to learn about the different types of

quantitative research and to acquire the basic skills to produce a quantitative

research report.

In the natural and social sciences, quantitative research is the systematic empirical
study of observable phenomena using statistical, mathematical, or computational

techniques. Figure 2.1 shows different aspects of the quantitative study.

The basic characteristics of the quantitative study (in comparison to qualitative) are:

— Data are collected using structured research instruments (surveys, structured
interviews, experiments, observations, reviews of records or documents where

any variable can be measured);
— itanswers the questions: What? When?;

— it is mostly based on numbers;
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usually, a deductive process is used to test the predefined concepts, constructs,
and hypotheses;

the results are based on larger sample sizes that are representative of the
population but provide less in-depth information;

the research study can usually be repeated;

the researcher has a clearly defined research question which demands objective
answers;

all aspects of the study are carefully designed before data collection;

data are in the form of numbers, and results are often arranged in numerical
tables, graphs, figures, or other non-textual form;

broader understanding of concepts, predicting future results, or exploring a
causal relationship;

provides the observed effects (interpreted by the researchers);

the researcher uses tools, such as questionnaires or computer software, to collect
numerical data;

usually, more time is needed in the planning phase and less in the analysis phase;
the overall goal of a quantitative study is to classify characteristics, count them,

and build statistical models to try to explain what we observe (Watson, 2015;
Holton & Burnett, 2005; Reaves, 1992).

Quantitative
research may
include:

Expetrimental

control and
manipulation of
variables

Figure 2.1: Different Aspects of Quantitative Study
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The types of quantitative study are shown in Figure 2.2.

Experimental research
Randomized controlled trial (RCT)

Quasi-experimental research

Pre- and post-test (without randomization)
Time series

Non-experimental research
Cohort study Correlation
Case-control Survey

Figure 2.2: Quantitative Study Types

Researchers sometimes classify types of studies differently. Thus, instead of
descriptive and correlation studies, they often refer to observational and quasi-
experimental and experimental research intervention studies. Observational studies
include cross-sectional studies, case studies with controls, cohort studies
(retrospective, prospective), case studies, and case series studies. The experimental
study is used to determine whether there is a cause-and-effect relationship between

variables.

The following are basic definitions of the most common quantitative study types:

— Randomized controlled trial (RCT): In randomised controlled trials,
participants are divided into an experimental group and one or more control
groups. The only difference between the groups is the intervention being studied
(Fig. 2.3). Studies can be known as single-, double- or triple-blind randomised
controlled trials. Single-blind means that the participants do not know which
group they are allocated to, double-blind means that the researchers collecting
the data do not know which of the participants belongs to a control or
intervention group and triple-blind means that the researchers analysing the data
do not know which group anyone was in (Stanley, 2007; Spieth, et al., 2016).
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Treatment Group
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Figure 2.3: Randomized Controlled Trial

Pre- and post-test study (without randomization): This is a type of quasi-
experimental study where the outcome of interest is measured twice, with variables
measured before and after the intervention (Fig. 2.4). Participants are selected in a
non-random way (Dugard & Todman, 1995; Marsden & Torgerson, 2012).

Pre-intervention Post-intervention
measurement measurement
- > Time
Before After

Figure 2.4: Pre- and Post-Test Study

— Cross-sectional study: A cross-sectional study is a study that analyses data on
variables collected over a given period (Fig. 2.5). It also measutes the outcome
and exposure of the study participants at the same time. Participants are selected
based on inclusion and exclusion criteria established for the study.
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Figure 2.5: Cross-Sectional Study

— Longitudinal study: Data are collected over time at different time points (Fig.
2.6). The researchers observe and collect data without trying to influence the

variables.
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Figure 2.6: Longitudinal Study

— Cohort study: In cohort studies, researchers investigate the links between risk
factors and outcomes.

— Retrospective cohort study: A retrospective cohort study is a longitudinal
cohort study that compares cohorts of individuals where one group is exposed
to a factor and the other is not. This is to determine the impact of that factor
on the phenomenon. They have the advantage that they can be catried out
immediately because they look at the situation retrospectively but may have less
control over the exposure of the participants to the factor.

— Prospective cohort study: This is a longitudinal study that follows groups of
similar individuals over time, differing in a trait/factor that may influence a

particular condition.

Prospective research

< Retrospective research >

Cross-sectional research
Figure 2.7: Types of Studies According to the Time of Data Collection

— Case-control study: Comparison of two groups of people, where one group
has the condition in question and the other group does not (Fig. 2.8). Here,
researchers look at the history of the participants (health, lifestyle) to see which

factors are associated with a particular condition.
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Figure 2.8: Case-Control Study

— Correlation study: Correlational study is used to study the relationships
between different subjects and variables. A correlational study is non-
experimental, meaning that none of the variables are influenced or controlled
by the researcher. We distinguish between positive or negative correlation and
no correlation. Correlational studies cannot prove cause-and-effect relationships
between vatiables.

— Survey study: Descriptive surveys are used to formulate a hypothesis, but only
after all the necessary data have been collected. Participants in the survey answer
a set of questions asked by the researcher. These surveys are mainly carried out
at the beginning of projects or larger research studies to identify the problem
and the direction of the study.
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Methods, in general, can be divided into data collection methods, data analysis
methods, data synthesis methods, and data display methods. These depend on the
study plan or type of study.

Quantitative methods emphasize the use of objective measurements and statistical,
mathematical, or numerical analysis of data collected through surveys or
questionnaires and or the manipulation of existing statistics using computational
techniques. The quantitative study focuses on the collection of numerical data and
their generalization by groups of people or the explanation of a particular

phenomenon.

Before designing a quantitative survey, we need to decide on a study plan/design
that will determine how the results are collected, analyzed, and interpreted. In a
descriptive study, we follow the following rules: the object of study is usually
measured once; the purpose is only to establish links between the variables; the study
may include a sample population of hundreds or thousands of subjects to provide a
valid estimate of the overall relationship between the variables. The experimental
design includes subjects measured before and after a particular treatment. The
sample population can be very small and purposefully selected, and it is designed to
establish causality between variables. Figure 2.9 shows the steps in a quantitative
study.

Analysis of
the literature

Research
question and
hypotheses

Preparing a
research plan

Analysis and Discussion
interpretatio and
n of results conclusions

Collection of
data

Figure 2.9: Quantitative Study Process
Source: (Kmetec, et al., 2019; Grove, et al., 2015)
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The main features of a quantitative study concerning individual sections, when

reported in a scientific paper, are described below.
2.1 Introduction

The introduction to a quantitative study is usually written in the present tense and

from a third-party perspective. It covers the following data:

— Identifies the research problem - as with any academic study, we should
clearly and concisely state the research problem.

— Reviews the literature - review studies on this topic, synthesize key topics, and,
if necessary, list studies that use similar methods of investigation and analysis.
Consider where there are key knowledge gaps and how your study helps fill
those gaps or clarify existing knowledge.

— Describes the theoretical framework - give an outline of the theory or
hypothesis on which your study is based. If necessary, identify unknown or
complex terms, concepts, or ideas and provide relevant background information

to place the research problem in an appropriate context.
2.2 Methodology and Methods

The sketch on the quantitative study methods should describe how each goal of your
study will be achieved. Provide sufficient detail to enable the reader to make an
informed assessment of the methods used to obtain results related to the research

topic. The section on methods should be presented in the past tense:

— Sample and sampling - where the data comes from; note where gaps exist or
what has been ruled out. Follow the procedures used to select them.

— Data collection - describe the tools and methods used to collect information
and identify variables; describe the methods used to obtain the data; note if the
data already existed or you collected them yourself. If you collected them
yourself, describe what instrument you used and why. Note that no data set is
complete - describe any limitations in data collection methods.

— Data analysis - describe the procedures for data processing and analysis. Where

appropriate, describe the specific analysis instruments used to study each
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research objective, including the mathematical techniques and the type of
computer software (e.g., Jamovi, JASP, Orange, R, etc.) used to process the data.

2.3 Results

The study findings must be reported objectively and in a concise and accurate
format. In quantitative studies, it is common to use graphs, tables, and other non-
textual elements to help the reader understand the data. Make sutre that the non-
textual elements do not stand apart from the text but are used to supplement the

general description of the results and to clarify the key tense.

— Statistical analysis - how did you analyse the data? What were the key findings?
The findings should be presented in a logical sequence. Describe but do not
explain these trends or negative results; save this for discussion. The results

should be presented in the past period.
2.4 Discussion

The discussion should be analytical, logical, and comprehensive. The discussion
should combine your findings in conjunction with the findings of the literature
review and place them in the context of the theoretical framework on which the

study is based. The debate needs to be presented at present:

— Interpretation of results - re-emphasize the study problem and compare the
findings with the research questions on which the research is based. Did you
confirm the announced results, or did you refute them with the data?

— Description of trends, comparison of groups, or relationships between
variables - describe any trends that have emerged from your analysis and
explain any unforeseen and statistically significant findings.

— Discussion of consequences - what is the meaning of your results? Highlight
key findings based on general results and consider findings that you consider
relevant. How do the results help to fill gaps in understanding the research
problem?

— Limitations - describe any limitations or unavoidable biases in your study and,
if necessary, consider why these limitations did not hinder the effective

interpretation of the results.
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2.5 Conclusion

Completing studies means summarizing the main findings of your research and

giving a final comment or guidance:

— Summary of findings - do not report statistics; provide a narrative summary
of key findings and synthesize answers to your research questions.

— Recommendations - if appropriate for the aim of the research, link the key
findings to policy recommendations or actions to be taken in practice.

— Future research - consider the need for future research related to study
limitations or other gaps in the literature that have not been addressed in your

study.

Different types of quantitative studies will demand different structures and
requirements for reporting the results. Therefore, it is suggested to follow
EQUATOR's  (https://www.equator-network.org)  internationally  accepted
guidelines for the presentation of different quantitative studies.
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3 Sampling and Sample Size

The following section presents the basic features of sampling, including the
theoretical background and practical applications. The different types of sampling
such as simple random sampling, stratified sampling, systematic sampling and other
relevant methods are discussed in detail. It also explains the process of sample size
calculation using SPSS software. The learning objectives of this chapter are to
enable the reader to understand the basic concepts and importance of sampling in
the research process. The reader will become familiar with the different types of

sampling and their characteristics. It will also provide practical knowledge of how

to perform sample size calculations using SPSS. It also aims to develop the ability

to evaluate critically and select the appropriate sampling method according to
specific research needs, which is crucial for conducting high quality and reliable

research.

The statistical population consists of all the participants in the group about which
you want to draw inferences by observation. The statistical sample represents the
individual part of the group (subgroup) from which the data will be collected (Fig.
3.1). The statistical unit represents one individual member of the population
(element of the set).
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S8 BB,
Q20 B
8% .

Population

Figure 3.1: Statistical Sample

Sampling methods fall into two broad groups: probability samples, where each
element has a known probability of occurring in the class, and non-probability

sampling, where the above condition is not met.

— Simple random sampling: Individuals are randomly selected from the total
population. This gives a sample that is not necessarily representative (Fig. 3.2)
(Simkus, 2022).

2908 B
5o (B,

Sample

Population

Figure 3.2: Simple Random Sampling
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— Stratified sampling: The population is divided into classes according to certain
characteristics (e.g., sex, age class, etc.). Then, random sampling (proportional

or disproportionate) is carried out from each class.

N
2.0,

Sample

Population
Figure 3.3: Stratified Sampling

— Systematic sampling: The first element is selected randomly, followed by
every kth element (k = population size/sample size).

2808 B85

Sample
[} |

Population

Figure 3.4: Systematic Sampling

— Cluster sampling: Use known information on the grouping of elements

(sampling by provinces, localities, communities, by schools, classes, etc.).
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Population

Sample

Figure 3.5: Cluster Sampling

Snowball sampling: First, we select a smaller sample of more accessible
individuals, who are asked to disseminate the sample or questionnaire through

their contacts.

Figure 3.6: Snowball Sample

Convenience sampling: A convenience/occasional sample simply includes

individuals who are most accessible to the researcher (Simkus, 2022).
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Figure 3.7: Convenience Sampling

— Purposive sampling: the researcher uses his/her expertise to select the sample

that is most useful for the purposes of the research.

Figure 3.8: Purposive Sampling
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3.1 Calculating the Required Sample Size Using SPSS

One of the frequently asked questions during the study planning phase is, “How
many participants do I need to test my hypothesesr”. The answer to this question is
not straightforward. In fact, we could write a whole book on different techniques of
so-called power analysis that can be used to estimate the minimal required sample
size for a given hypothesis. Calculating the sample size is key to ensuring accurate
and reliable results, as it reduces the error rate and increases the precision of the
estimates (Andrade, 2020).

As already mentioned in the initial chapters, to test the hypothesis, we need to know
some characteristics of our data — especially the type of variables and distribution of
collected data for the variables that are involved in the hypothesis testing.

There are many specialized computer programs available that allow us to conduct
Power analysis. However, from IBM SPSS version 27, it is also possible to use the
Power analysis function directly in the SPSS (Analyze -> Power Analysis).

File Edit View Data Iransfom Analyze Graphs Utiities Extensions Window Help

[ - - - -
| N=] g " gy | RIS > Means > [ One-Sample T Test
Weta Aralysie > Propottions > By pireq-Samples T Test
L Report > "
fal &2 Degu 5( _— . Correlations > g ndependent-Samples TTest  op; o & 5000LC
escriptive Statistics R > X = =
L b [ One-Way ANOVA 1 2

4 69 2 Bayesian Statistics > 4 b . ; 4 4
2 45 2 Tables > 4 3 2 1 5 §
3 59 1 Compare Means > -1 1 1 1 5 3
& Li 2 General Linear Model > 4 2 1 1 3 3
> 43 2 Generalized Linear Models > 4 i J L 3 3
6 83 2 Vixed Model N 3 3 3 2 3 3
7 45 2 Epoiodes 4 2 1 T 3 3
- 5 = Correlate > . - : ) B B
9 46 2 Regression > 1 2 1 1 5 5
10 A 1 Loglinear > 4 2 1 2 3 3
" 54 1 Neural Networks > 4 3 1 1 5 5
12 6 1 Classiy B 1 2 1 1 3 3
L &7 L Dimension Reduction > ' 2 2 1 3 1
n A 2 1 3 3 1 5 5

Scale >
15 81 2 4 2 1 1 5 4
16 51 P Nonparametric Tests > 1 3 7 3 . 3
17 65 2 Forecasting ? 1 3 3 1 3 2
18 64 2 Sunvival > 4 2 1 1 5 5
19 - 4 Multiple Response > 4 2 1 1 4 4
20 59 2 Missing Value Analysis. 4 4 3 2 1 1
2t 2 L Multiple Imputation > £ L » L 5 §
2 19 1 B » 1 1 3 3

< Complex Samples >

Data View Variable View &) Simulation
Oualitu Coanteal >

Figure 3.9: Power Analysis in SPSS
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As it can be seen from Fig. 89, as of the IBM SPSS 28, the Power Analysis function
in SPSS allows estimation of minimal sample size for four different groups of
statistical tests:

— Comparison of means (univariate and bivariate t-tests, One-way ANOVA).
— Proportions (univariate and bivatiate binomial tests).
—  Correlations (Pearson, Spearman, partial).

— Regression (univariate linear).

Here, we provide a step-by-step demonstration of using the SPSS Power Analysis
function to estimate the minimal required sample size for an independent t-test
scenario.

After the selection of the Awalyze -> Power Analysis -> Means -> Independent-Samples t-
Test, we are asked to enter information for both compared groups (Fig. 3.10).

#2 Power Analysis: Independent-Sample Means X

Test Assumptions

@ Estimate sample size;
@® Single power value: l:l

O Grid power values: = Grid

Group size ratio:

O Estimate power

® Population mean difference: |:]

O Population mean for group 1:

Population standard deviations are

® Egual for two groups

Pooled standard deviation: l:l

O Not equal for two groups

Test Direction
® Nondirectional (two-sided) analysis

O Directional (one-sided) analysis

Significance level:

Figure 3.10: Power Analysis for Independent-Samples t-Test
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In this step, we will have to provide the “Single power value”, which is usually set at
0.90 or 0.95. Figure 3.11 shows an example of the minimal sample size estimation
for a scenario where we performed a pilot study on a small sample of students,
measuring student satisfaction (measured on a scale from 1 to 5) of the

undergraduate (group A, n=25) and postgraduate (group B, n=23) students. We
obtained the following results:

— Average satisfaction level in group A was 4.5, and 4.8 in group B;
— Standard deviations of 0.9 (group A) and 0.8 (group B) were calculated;
— In the hypothesis we were interested only whether there are any differences in

average satisfaction between undergraduate and post-graduate students
(Nondirectional, two-sided analysis).

t—! Power Analysis: Independent-Sample Means X

Test Assumptions Plot
@® Estimate sample size

® Single power value:

O Grid power values: = Grid

Group size ratio:

O Estimate power

O Population mean difference:

® Population mean for group 1: and group 2:

Population standard deviations are

O Egual for two groups

® Not equal for two groups
Standard deviation for group 1: and group 2:

Test Direction
® Nondirectional (two-sided) analysis

O Directional (one-sided) analysis

Significance level:
| Paste | l Reset ‘

Cance\” Help ‘

Figure 3.11: Power Analysis Data Entry Example
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Power Analysis - Independent Sample Means

Power Analysis Table

Test Assumptions

Mean
N1 M2 Actual Power® Fower Std. Devl  Std. Dev2 Difference Sig.

Testfor Mean Difference® 21 21 951 85 4 8 300 .05

a. Two-sided test.
b. Based on noncentral t-distribution

Figure 3.12: Results from the Power Analysis for an Independent Samples t-Test
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4 Review of Statistical Basics

The next section introduces basic statistical concepts, such as hypotheses and
variables, and provides basic information about basic descriptive statistics in SPSS
software. The chapter also introduces the different statistical tests that are
performed in SPSS. The learning objectives of this chapter are to enable the reader
to understand basic statistical concepts and their importance in the research
process. The reader will become familiar with formulating and testing hypotheses

and will learn about the different types of variables and their influence on research

results. They will also acquire basic skills in descriptive statistics in SPSS, including

mean, median and standard deviation. Finally, the reader will learn how to petform
and interpret various statistical tests in SPSS, such as t-tests, ANOVA, correlation
tests and others. This chapter will provide the reader with a comprehensive

understanding of key statistical concepts and methods.

Statistics is a fundamental tool in nursing, enabling nurses to analyse data
systematically, which is key to improving the quality of patient care and making
informed decisions. Understanding statistical concepts is essential for critically
evaluating research studies that help to identify the most effective therapeutic
approaches, establish associations between different risk factors and treatment
outcomes, and optimise the management of healthcare resources.
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Understanding statistics also enables nurses to evaluate critically and apply research
tindings in their daily practice. This enables them to make more informed, evidence-
based decisions that improve patient care and enhance the professionalism of their

work:

— Statistical population - These are all the objects (or “entities”) that we observe;
mathematically, the universal set.

— Statistical unit - Individual member of the population; the element of the
crowd.

— Statistical sample - Part of the population; a subset.

— Statistical variable - Property of individual members of the population.

— Statistical parameter - Measured quantity describing a statistical population.

Hypothesis

— A hypothesis (plural hypotheses) is a proposed explanation for a phenomenon.
— An assumption that can be empirically verified.
—  Counsists of variables (descriptions, unit properties).

— Working, null, alternative, non-directional, directional.

We talk about a hypothesis when the problem is specific and well-defined and,
therefore, can be formulated into a claim, which is then accepted or rejected by
certain statistical tests. A hypothesis is an assumed statement of the relationship

between two or more variables.

The null hypothesis (Ho) states that there is no statistically significant difference or
relationship among variables. The working hypothesis (H,, Hi) states exactly the
opposite.

Using the p-value, we determine the degree of confidence with which we can reject

the null hypothesis:

— Simple: shows a relationship between one dependent and one independent
variable.
— Complex: shows the relationship between two or more dependent variables

and two or more independent variables.
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Directional: the hypothesis assumes a relationship between two variables and
is based on existing theory (E.g. Women are more confident in taking self-care
for their diabetes).

Non-directional: is used when no theory is involved. It is a statement that a
relationship exists between two variables without predicting the exact nature
(direction) of the relationship (E.g. There is a difference in diabetes self-care
confidence between women and men).

Null: provides the statement which is contrary to the hypothesis. It is a negative
statement, with no relationship between independent and dependent variables
(E.g. The average diabetes self-care confidence score is 60).

Associative and causal: Associative hypothesis occurs when there is a change
in one variable, resulting in a change in the other variable. Causal hypotheses

propose a cause-and-effect interaction between two or more variables.

Variables

To test hypotheses, we need to collect enough data for the variables involved in
a hypothesis. A variable that causes a condition to develop is known as an
independent variable because its values are independent of other variables. A
variable that is influenced by an independent variable is called a dependent

variable because its value depends on the cause (Fig. 4.1).

VARIABLES

ATTRIBUTIVE NUMERICAL
VARIABLES VARIABLES

|
02 v

NOMINAL ORDINAL DISCRETE CONTINUOS

These are qualitative variables that Defined as those whose data can Continuous variables are expressed as

These are variables that measure

measure a characteristic but cannot only be represented by integers. any number in the set of real numbers,

be classified on the basis of that characteristics and can be classified including numbers with decimal places.
on that basis (e.g. by size - large,

characteristic (e.g. gender, marital o, Gl Gital)

status, etc.).

Figure 4.1: Type of Statistical Variables
Source: (Liguori & Moreira, 2018)
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4.1 Start the IBM SPSS Software Package

To run SPSS, double-click on the icon @

A Welcome to 1BM SPSS Statistics X

lew Files: What's New:
(&) New Dataset Relationship Map
(&9 New Database Query.

Vadable

Restore Points

1>

Auto-Recovery Data Editor |Untitled1* [
Sep 14, 2021 10:00:10 AM

Output | Output1”

o Auto-Recovery Data Editor | sleep-sav [
Sep 13, 2021 5:00.24 PM

Output | Output1®

Auto-Recovery Data Editor | steep-sav ] Relationship maps are useful for determining how variables relate
Sep 13, 20214:09.05PM o each other by providing a visual representation ofthe
Auto-Recovery Data Editor |sleep sav* m z::\:'emuns andinfluences that each node and link has over each
Sep 13, 2021 1:31:45 PM

Auto-Recovery Data Editor | slesp.sav* T

Sep 13, 2021 1:21:45 PM s Help & Support Tutorials Community

Restore Points Recent Files  Sample Files

Visit SPSS Statistics page to explore available Give Feedback
ackages and ofers
pactas Report Issus
Spen

[1Dont show this dialog in the futurs

Figure 4.2: Start the SPSS Package

For SPSS analysis, we can use:

— data prepared for analysis in SPSS format (.sav file);
— data downloaded from other programs (e.g. Excel);

— data entered manually in the Data Editor window.

Elle Edt View Data Transorm Analyze Graphs LUtiities Extensions Window Help

L LAWK BE JeEQ

>
s Opata Fl Values Missing  Columns Align Measure Role
Import Data ¥ Intemet Data
|3 General Open @ syntax
- D ouy
£ Open Restore Point g
~ [}
@ Script
|
¥ Save All Data
»
Export >
» R
=]

Collect Variable Information
[ Rename Dataset

Display Data File Information >
2 Cache Data
L]
4 Switch Senver.
Repository. >
R
&
Welcome Dialog
Recently Used Data >
Recently Used Files >

Manage License

Figure 4.3: Importing Data Into SPSS
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The Data View shows the dataset (Fig. 4.4). The columns represent variables, and

the rows represent individual cases. Variable View shows information about the

variables.

File Edit View Data Transform Analyze Graphs Utilities Extensions Window Help
=] &2 > a BE 4 iz = Al

EEHe D e~ BLIE A EBESE J0EQ

var var ar var var var var var var var
1
2
4
6
9
10
"
12
13
14
15
16
17
Data view 18 Data view

(data entry) (data entry)

\ 2 //
N - < =

Data View Variable View

Figure 4.4: Data View Window in SPSS

Variable View includes the following information:

— name of variable;

— type of variable (e.g. string, numeric, etc.);

— number of signs (Width);

— number of decimal places (Decimals);

— variable brief description (Label);

— description of the variable value for coded categorical variables (Values);

— missing values (Missing);

— width of column (Columns);

— alignment of the variable values in Data View — can be left, right or center
justified (Align);

— type according to measurement (Measure; e.g., nominal, ordinal, or scale);

— role (e.g., input, target, both, etc.).
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File Edt View Data Transform Analyze Graphs Utiities Extensions Window Help

EHE He~FhIE A RE J0EQ

Name Type Width ~ Decimals Label Values Missing ~ Columns Align Measure Role
1 a1 Numeric 3 0 Age (years) {99, I don't know} 991 8 = Right & Scale e Input
2 Q2 Numeric 3 0 Gender. {-99, | don't know}. -99--1 8 & Nominal N Input
3 Q3 Numeric 3 1 Education {-99.0, | don't know}. -99.0-10 8 & Nominal N Input
4 [ Numeric 3 0 Are you employed? {99, | don't know}... 99--1 ] & Nominal N Input
5 Qs Numeric 3 0 What is your marital__ {-99, | don't know}. 99--1 8 & Nominal N Input
6 Q9 Numeric 3 0 Does anyone in you... {-99, | don't know). -99--1 8 & Nominal N Input
7 [ Numeric 3 0 How would you rate .. {-99, | don't know}. -99--1 8 & Nominal N Input
8 an Numeric 3 0 How would you rate ... {-99, | don't know}. -99--1 8 & Nominal N Input
9 Qu Numeric 3 0 Do you think you ha... {-99, | don't know}... 99--1 ] & Nominal N Input
10 SCODIC1  Numeric 3 0 Check your blood s... (-9, | don't know}. -99--1 8 & Nominal N Input
" SCODI_C2  Numeric 3 0 When you have abn... {-99, | don't know}. -99--1 8 & Nominal N Input

Figure 4.5: Variable View

4.2 Creating New Variables
a) Compute Variable

In the following section, we were interested in how are confident patients with
diabetes in carrying out self-care activities and maintaining their health. Patients were
asked to answer eleven questions using a Likert scale from 1 to 4. The formula for

calculating the total score is given below:

Self-care Confidences = (SUM(SCODI_D1+ SCODI_D2+ SCODI_D3+ SCODI_D4+
SCODI_D5+ SCODI_D6+ SCODI_D7+ SCODI_D8+ SCODI_D9+ SCODI_D10+
SCODI_D11)-11)*(100/44)

To calculate a new variable from the given variables, we can use the Compute
Variable function (Fig. 4.6).

Gle Edt View Data Iransform Analyze Graphs Utiities Exte 2 Compute Variable x
=] ng g 5 Compute Variable
: . [+] Target Variable Numeric Expression
+ e ™ e E Caunt Values within Cases Confidences - [ ((scopi_p1+SCODI_D2 + SCODI_D3 + SCODI_D4 + SCODI_D5 + SCODI_D6 + SCODI
_D7 + SCODI_D8 + SCODI_D9 + SCODI_D10 + SCODI_D11) - 11) * (100/44)
2 @ Nu  Shift Values Type & Label
3 |o3 " 59 Recods into Same Variables.
4 Q4 -
e oDt v 2o @12 [
ender
6 Q9 Nu [ Automatic Recode & Education: [Q3] Function group:
7 awn Nu [ Create Dummy Variables & Are you employed :{” .
. ithmetic
Z 2:} :" [ Visual Bining. & What is your mari CDF & Noncentral CDF
o |scoorer N" B Optimal Binning, & Does anyone in y. Comversion
u
11 SCODLC2 Ny Prepare Data for Modeling > &b How would you rat Current Date/Time
12 SCODI_C3  Nu B4 Rank Cases. | & How would you rat g:e /meg‘r?‘enc
e Creation v
13 SCODLC4 N g Date and Time Wizard ! ﬁ g: y‘:‘ ‘“'”kh:/m;
14 SCODLCS Nu eck your bloot El EI . _ Functions and Special Variables
- [ Create Time Se Delete
15 SCODI_C6  Nu &8 Create Time Series &b When you have a ka
16 SCODIC7 Ny % Replace Missing Values, & When you have a N
17 SCODI_C8  Nu @ Random Number Generators. & When you have s
B SCODLCY N g i & Ifyou find out that
19 SCODI_C10  Numenc 3 v 7 you nna out tat & Ifyou find out that
20 SCoDI_D1 Numeric 3 0 Prevent high or loy & After taking action
21 SCODI_D2  Numeric 3 0 Follow advice abo & If you find out that B =
22 SCODI_D3  Numeric 3 0 Take your medicir
23 SCODI_D4  Numeric 3 0 Persist in followin "
- tional lecti dit
2% SCODI_D5  Numeric 3 0 Monitor your blooc (optional case selection condtion)

<

Data View Variable View

Figure 4.6: Compute New Variable
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b) Record into Same or into Different Variables

If we want to map the existing values of a variable into new values, but do not want
to create a new variable, we can use the Recode into Same Variables function. If we
want to convert existing variables into new ones, we can use the Recode into
Different Variables function (Fig. 4.7). In case we also have missing values, we need

to add the conversion of the missing values back into the missing values.

File Edit View Data Transform Analyze Graphs Utilities Extensions Windo

H L%] g # Compute Variable. % E

Programmability Transformation. ..

Name Values
1 a1 N [ Count Values within Cases {99, | don't
2 Q2 N Shift Values {99, 1 don't
3 Q3 N & Recode into Same Variables.. {:99.0, | donr.
4 Q4 N . y . {-99, I don't
5 Qs N mﬂecode into Different Variables... (99, 1 dont
6 Q9 n [ Automatic Recode {99, 1 don't
7 Q10 N 3 Create Dummy Variables {99, I don't
LJ an N [}§ Visual Binning... {99, | dont
9 Q14 N {99, I don't
[i Optimal Binning... y
10 SCODI_C1 N . {99, I don't ..
11 |scopica | Erepare Datafor Modeling > {99, Idont
12 SCODI_C3 N BARank Cases {99, I dont .
13 SCODI_C4 N & Date and Time Wizard.. . {99, I dont ..
14 SCODI_C5 N [ Create Time Series - {99, I don't ..
15 SCODI_C6 N = o - {-99. I don't ..
16 scopc7 | i Replace Missing Values.. 99, I dont ..
17 SCODI.C8 N @ Random Number Generators.... _ {99, I dontt ..
18 SCODICI Ny g {99, I don't
19 SCODI_C10  Numenc 3 u myounnaoutt.. {-99, | dont
20 SCOoDI_D1 Numeric 3 0 Prevent high or ... {-99, | dont
21 SCODI_D2  Numeric 3 0 Follow advice a_.. {-99, | dont
22 SCODI_D3  Numeric 3 0 Take your medi... {-99, | dont
23 SCODI_D4  Numeric 3 0 Persist in follow... {-99, | don't
24 SCODI_D5  Numeric 3 0 Monitor your bl... {-99, | don't
<
Data View Variable View
@Recode into Different Variables X
Numeric Variable -> Qutput Variable: Output Variable

@0 1 yUUu U uuL un

& Do you take ins._ Confidences —> Confidences_descri... Name:

&> If you find out th._. Confidences_descriptive

&5 Prevent high or | Label-

&5 Follow advice a... -

&> Take your medi... |:|
&> Persist in follow...
&5 Monitor your blo...
&> Understand if y__

&> Recognize the

&> Persist in monit.__
&> Take action to a..
&) Evaluate if your ...
&> Persist in carryi...

Old and New Values. ..
(optional case selection condition)

‘ Help ‘

<]

oK Paste | Reset ||Cance\

Figure 4.7: Recode Into a New Variable
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We divided the values on a scale from 0 to 100 into four parts. O to 25 was low self-
confidence, 25 to 50 was insufficient self-confidence, 50 to 75 was adequate self-
confidence and 75 to 100 was good self-confidence.

G Recode into Different Variables: Old and New Values x
Old Value New Value
O Value: @© Value: ‘

O System-missing
O System-missing O Copy old value(s)
O System- or user-missing

Old > New
©Range: 0 thru 24 > 1

50 thru 74 > 3

through A
[roug S 75t 100> 4
L 1 Ghange

O Range, LOWEST through value: Remove

O Range, value through HIGHEST:
[[] Output variables are strings

O All gther values B Conve

Figure 4.8: Define New Variables
4.3 Steps for Conducting Descriptive Statistics in SPSS
a) Frequencies

We click the following: Analyze -> Descriptive Statistics -> Frequencies.

File Edit View Data Transform Analyze Graphs Utiities Extensions Window Help
= & g Pouer Analysis > BE= (A Q
H& = i q Q@

Meta Analysis >
Reports

>
it e Descriptive Statistics > oo &au o 55010‘}
1 69 2 Bayesian Statistics > BDescrpives 3 ol
: = 2 Tebles > 3 Population Descriptives 1 5
D 59 1 Compare Means 2 Fy 1 5
4 10 2 General Linear Model o - 1 E
rosstabs
2 e 2 Generalized Linear Models > N 1 3
6 83 2 [ TURF Analysis 2 3
Mixed Models >
7 45 2 [ Ratio 1 3
Correlate > HE
8 54 1 - 2 =]
9 % 2 Regression , [ Proportion Confidence Intervals F 5
10 A 1 Loglinear > P-P Plots. 2 3
" 54 1 Neural Networks > Q-Q Plots. 1 5
12 46 1 Classify 5 1 2 1 1 3
£ o i Dimension Reduction > il 2 2 1 3
i 4 2 1 3 3 1 5
Scale >
15 81 2 4 2 1 1 5
16 51 2 Nonparametric Tests > 1 3 2 7 7
7 r 2 Forecasting > T 5 5 7 3
18 64 2 Sunival > 4 2 1 7 B
19 E] ] Multiple Response > 4 2 1 1 4
2 59 2 EZMissing Value Analysis 4 4 3 2 1
21 5 d Multiple Imputation > - 4 1 1 5
2 49 1 2 2 1 1 3
< Complex Samples >
Data View Variable View &3 Simulation.
—_— Qualitys Contenl >

Figure 4.9: First Step in Choosing Frequencies Function
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If you also want to display the variables as an illustration, click Charts, select the type
of chart (Bar, Pie, Histogram) and specify whether you want to show frequencies or

petcentages.
@F equencies . #3 Frequencies: Charts X
: . Chart Type
—_—
@b Monitor your bloo... &> Confidences_descri... — O Nane
&b Understand if you... @ Bar charts!
Recognize the sy...

% F'ersigt in monitoyr Iﬂl O Pie charts

&b Take action to adj... O Histograms:

&> Evaluate if youra... O she

&> Persist in carryin. ..
& Confidences v Chart Values

Display frequency tables [[] Create APA style tables © Erequencies O Percentages

| Paste | | Reset | ‘Cance\ | | Help ‘

Figure 4.10: Choosing Variables When Conducting Frequencies Function

Results are presented in two tables:

Frequencies
Statistics
Confidence_descriptve
M Walid 101
Missing 40
Confidence_descriptve
Cumulative
Frequency Percent  Valid Percent FPercent
Valid Low self-confidences 1 ) 1.0 1.0
Insufficient self- 3 21 30 40
confidences
Adequate self- 34 241 337 376
confidences
Good self-cnfidence 63 44.7 62.4 100.0
Total 101 71.6 100.0
Missing  System 40 28.4
Total 141 100.0

Figure 4.11: Results When Conducting Frequencies Function



34 ADVANCED QUANTITATIVE RESEARCH METHODS IN NURSING

The results are shown using frequencies and percentages. The valid percentage and
cumulative percentage are also shown. The valid percentage is the percentage of
cases that have non-missing values for each category. The cumulative percentage is

the calculation of the valid percentages for each category or for previous categories.

The results can be reported as follows: One participant (1.0%) had low self-
confidence, three participants (3.0%) had insufficient self-confidence, 34
participants (33.7%) had adequate self-confidence, and 63 participants (62.4%) had
high self-confidence.

The results can also be plotted using graphs.

Confidence_descriptve

B0

Frequency

20

-

0 4,

Low sef-confidences Insufficient self- Adequate self- Good self-cnfidence
confidences confidences

Confidence_descriptve
Figure 4.12: Results in Graphs When Conducting Frequencies Function
b) Descriptives

We click on Analyze -> Descriptive Statistics -> Descriptives.
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File Edit View Data Transform Analyze Graphs Utilities

H gﬂ g W % Pouer Analysis

‘ Meta Analysis
Regorts > =
& a1 &2 Descriptive Statistics > au
1 69 2 Bayesian Statistics > [ psscripties 1
= 4 2 Tables > Population Descriptives 1
3 59 1 Compare Means > Al 1
4 70 2 General Linear Model > 1
5 23 2 B8 Crosstabs 1
Generalized Linear Models >
6 83 2 TURF Analysis 2
Mixed Models >
7 45 2 ) Ratio. 4
8 54 ] Correlate > = 2
5 . 2 Regression N Proportion Confidence Intervals 1
10 1 1 Loglinear > P-P Plots 2
" 54 1 Neural Networks > EQQPiots... 1
12 46 1 Classify > 1 2 1 1
i3 67 1 Dimension Reduction > 1 2 2 1
14 1 2 1 3 3 1
Scale >
15 81 2 ) 4 2 1 1
T o 2 Nonparametric Tests > ] B ) b
7 6 2 Forecasting > 4 3 3 1
18 64 2 Survival > 4 2 1 1
19 1 -1 Multiple Response > 4 2] 1 1
20 59 2 Missing Value Analysis 4 4 3 2
2 3 ! Multiple Imputation > A 4 1 1
2 49 1 2 2 1 1
< Complex Samples >
Data View Variable View  Simulation
_— Oualitv Contral >

Figure 4.13: First Step in Choosing Descriptives Function

Then click on Statistics, and we can choose different statistical parameters, such as
Mean, Minimum, Maximum, Standard deviation, etc.

@ Descriptives: Options X
[1Sum
Dispersion
Std. deviation [] Minimum
#3 Descriptives x [] variance Maximum
Variable(s): [JRange [JSE mean
& Gender: [Q2] & [ Age (years): [Q1]
Distribution

& Education: [Q3]

&> Are you employed? [Q4]

&> What is your marital st...

&> Does anyone in your fa... Display Order

&> How would you rate yo... . . .
@® Variable list

[JKurtosis  [] Skewness

&> How would you rate yo_.
&> Do you think you have ... O Alphabetic
&5 Check your blood sugar...

& When you have abnorm._. -
e ' : - O Descending means

[] Save standardized values as variables
]

O Ascending means

| Paste ‘ | Reset | ‘Cancel

Figure 4.14: Choosing Variables When Conducting Descriptives Function
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The results can be reported as follows: The average age of participants is 63.08 years
(SD=12.96), with a minimum age of 24 years and a maximum age of 87 years (Fig.
4.15).

Descriptives
Descriptive Statistics
M Minimum  Maximum Mean Std. Deviation
Age (years): 132 24 ar 63.08 12.961
Valid N (listwise) 132

Figure 4.15: Results When Conducting Descriptives Function
c) Explore

When choosing the function Explore, we can also choose different plots (e.g.,
Histogram, Stem and leaf, etc.) to present our data.

File Edit View Data Transform Analyze Graphs Utiities Extensions Window Help

H [E..J g W= “%  Power Analysis > é“:j 13 OE O\

Meta Analysis >
Visible: 32 of 32 Variables
2. Reports >
[e}] Q2 == T = Qu SCODI_C o SCODI.C o SCODI_C o SCODI_C o SCODLC g €
& Descriptive Statistics > [ Frequencies & TR, TSR, TR @
1 59 2 Bayesian Statistics > [ Desciiptives 1 4 4 4 4 4 A
2 45 2 Tables > 3 Population Descriptives 1 d 5 g 5 3
3 59 1 c M > 1 5 3 2 5 5
4 70 2 orpars Heans & Explore 1 3 3 3 3 3
General Linear Model > BB Grosstab A = 2 7 =
rosstabs
2 4 = Generalized Linear Models > = 4 & ) 1 3 B
6 83 2 TURF Analysis 2 3 3 4 5 4
Mixed Models >
7 45 2 & Ratio 1 3 3 3 3 3
Correlate > -
8 54 1 C 2 3 3 3 3 3
5 W o g s , [ Proportion Confidence Intervals B = = 2 3 :
10 A 1 Loglinear > [EE-PPlts 2 3 3 3 5 5
1 54 1 Neural Networks > EQQPots 1 5 5 3 5 4
12 46 1 Classify > 1 2 1 1 3 3 1 5 5
) L 1 Dimension Reduction > 1 2 2 1 3 1 1 4 4
14 Bl 2 1 3 3 1 5 5 3 5 5
Scale >
15 81 2 4 2 1 1 5 4 4 5 4
T o 3 Nonparametric Tests > 2 3 3 7 = - = A :
7 65 2 Forecasting % 1 3 3 1 3 2 3 2 4
18 64 2 Sunvival > 4 2 1 1 5 5 5 5 5
19 E] 4 Multiple Response > 4 2 1 1 4 4 1 3 4
2 59 2 Missing Value Analysis 4 4 3 2 1 1 1 1 1
2l ) 1 Multiple Imputation > =t 4 1 1 5 5 1 5 5
22 49 1 2 2 1 1 3 3 2 4 L et
< Complex Samples > >

B3 Simulation

Data View Variable View

Figure 4.16: First Step in Choosing Explore Function
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@Explore X @ explore: Plots
Dependent List: Boxplots Descriptive
@GO mEIRlLITUIUWINY. - &) Age (vears): [Q1] ® Factor levels together [ Stem-and-leaf
&5 Monitor your blood.... :
D dents togeth V] Hist:
& Understand if your . O Dependents together [M Histogram

&> Recognize the sy
&> Persist in monitori....
&> Take action to adju...
&> Evaluate if your act..
&> Persist in carrying ...
& Confidences

Display
® Both O Statistics O Plots

Eactor List:
& Confidences_descript....

Label Cases by:

| Paste H Reset |

Cance\” Help |

O None

Normality plots with tests

Spread vs Level with Levene Test
® None

O Power estimation
QO Transformed Powe

O Untransformed

Figure 4.17: Choosing Variables When Conducting Explore Function

Results are presented in three tables:

Case Processing Summary

Cases
Valid Missing Total

Confidence_descriptve M Fercent M Percent M Percent
Age (years). Low self-confidences 1 100.0% 0 0.0% 1 100.0%

Insufficient self- 3 100.0% 0 0.0% 3 100.0%

confidences

Adequate self- 3 91.2% 3 8.8% 34 100.0%

confidences

Good self-cnfidence 60 95.2% 3 4.8% 63 100.0%

Figure 4.18: Summary Result When Conducting Explore Function

Skewness is a measure of symmetry. Kurtosis is a measure of the distribution. When

the mean, median and mode coincide, it is called a symmetric distribution, i.e.

skewness = 0, kurtosis = 0. Skewness and Kurtosis parameters must lie between 1

and -1 for the distribution to be approximately normal. This is a less reliable method
for small to medium-sized samples (.e. n < 300) because it cannot adjust the

standard error. In this case, we apply a z-test using skewness and kurtosis (Mishra,

et al.,, 2019).
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Descriptives”
Confidence_descriptve Statistic  Std. Error
Age (years):  Insufficient self- Mean 7367 2728
-G 95% Confidence Interval Lower Bound 61.93
forhean Upper Bound 85.41
5% Trimmed Mean .
Median 72.00
Variance 22333
Stdl. Deviation 4726
Minimum 70
Maximum 78
Range 2]
Intergquartile Range .
Skewness 1.390 1.225
Kurtosis . .
Adequate self- Mean 64.35 2.075
confidences 95% Confidence Interval  LowerBound 6012
UL Upper Bound 68.59
5% Trimmed Mean 64.64
Median 67.00
Wariance 133.437
Std. Deviation 11.551
Minimum 41
Maximum a3
Range 42
Intergquartile Range 14
Skewness -.623 421
Kurtosis -.503 821

Figure 4.19: Descriptives Results With the Explore Function

For small samples (less than 50 units), the Shapiro-Wilk test is recommended,
although it can be used for larger samples, whereas the Kolmogorov-Smirnov test
can only be used for larger samples (more than 50 units). If the p-value is higher
than 0.05, we can confirm the normal distribution (Mishra, et al., 2019).

The results can be interpreted as follows: The Shapiro-Wilk test shows that the age
distribution is normally distributed in all three groups (Fig. 4.20).
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Tests of Normality®

Kolmogorov-Smirnoy” Shapira-Wilk
Confidence_descriptve Statistic df Sig. Statistic df Sig.
Age (years): Insufficient self- 304 3 . 907 3 407
confidences
Adeguate self- 135 3 158 934 3 056
confidences
Good self-cnfidence 075 60 2007 983 60 589

* This is a lower bound ofthe true significance.
a. Age (years): is constantwhen Confidence_descriptve = Low self-confidences. It has been omitted.

b. Lilliefors Significance Correction

Figure 4.20: Tests of Normality When Conducting Explore Function

The data distribution can also be viewed by looking at the histogram. The histogram
is an estimate of the probability distribution of the continuous variable. If we have
a bell-shaped and symmetrical graph about the mean, we can assume that the data
are normally distributed (Barton & Peat, 2014; Mishra, et al., 2019). In Figure 4.21,
we see the abnormal age distribution in people with insufficient and sufficient self-

confidence.

Histogram

for Confidence_descriptve= Insufficient self-confidences

Wean = 73.67
Std.Dev. =4.726
N=3

Frequency

70 72 74 7 EY

Age (years):

Histogram

for Confidence_descriptve= Adequate self

Mean = 64.35
Std_Dev. = 11551
N=31

Frequency

a0 E &0 70 £

Age (years):
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Histogram

for Confidence_descriptve Good self-cnfidence

Mean =653
Std. Dev. = 11.065
N=60

Frequency

&0

Age (years):
Figure 4.21: Histogram

The Q-Q normal plot (Fig. 4.22) shows the relationship between two sets of
quantiles (observed and expected). For normally distributed data, the observed data
are approximately equal to the expected data.

Normal @-Q Plot of Age (years):

for Confidence_descriptve= Insufficient self.confidences

Expected Normal

69 72 75 8 8

Observed Value

Normal Q-Q Plot of Age (years):

for Confid

iptve= Adequate self-

Expected Normal

Observed Value



4 Review of Statistical Basics 41

Normal Q-Q Plot of Age (years):

for Confidence_descriptve= Good self-cnfidence

Expected Normal

Observed Value

Figure 4.22: Q-Q Normal Plot
We can also assess the normality of the data distribution using a box plot (Fig. 4.23).

It shows the median as a horizontal line inside the box and the IQR (the range
between the first and third quartiles) as the length of the box.

a0

80

m =

60

Age (years):

50

40

Low self-confidences Insufficient self- Adequate self- Good self-cnfidence
confidences confidences

Confidence_descriptve
Figure 4.23: Box Plot

d) Crosstabs

Crosstabs can used to describe the relationship between two categorical variables.
We click the following: Analyze -> Descriptive Statistics -> Crosstabs.
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File Edit View Data Transform Analyze Graphs Utilities Extensions Window Help

ﬂ E%j g r ’ Power Analysis N E@ m“%] L:_‘@ IEI Q

>

P Reports E = =
S Q2 Descriptive Statistics > [ Frequencies... éau
1 69 2 Bayesian Statistics > @ Descriptives... 1
> |um
2 45 2 Tables Population Descriptives 1
3 59 1 Compare Means > 1
4 70 2 mp B Explore... 1
General Linear Model >
5 43 2 X . Crosstabs... 1
Generalized Linear Models >
6 83 2 ) [EZ TURF Analysis 2
Mixed Models >
v 45 2 [ Ratio -1
F 54 1 Correlate > - 2
9 46 5 Regression > Proportion Confidence Intervals 1
10 -1 1 Loglinear > P-P Plots... 2
" 54 1 Neural Networks > [EQ-QPlots... 1
12 46 1 Classify > 1 2 1 1
E &7 ! Dimension Reduction > ! 2 2 1
14 R 2 1 3 3 1
Scale >
15 81 2 4 2 1 1
16 51 Py Nonparametric Tests > 1 3 P 1
17 65 2 Forecasting > 1 3 3 1
18 64 2 Survival > 4 2 1 1
19 -1 -1 Multiple Response > 4 2 1 1
2 59 2 Missing Value Analysis... 4 4 3 2
2t 5 ! Multiple Imputation > 4 4 ! 1
22 Hﬂ—1; ? ? 1 1
< Complex Samples >
Data View Variable View &5 Simulation...
- Qualitv Contral >
Figure 4.24: Crosstabs
i@ Crosstabs ® W@ Crosstabs: Cell Display
Row(s): Counts z-test
& Age (years): [Q1] -~ |65 Gender: [@2] [V] Observed [[] Compare column proportions
& Education” [13] [] Expected [B Adjust pvalues (Bonferron
& Are you employed? [Q4] .
Hid: Il it
& What is your marital st... Column(s)- Dtide s‘ma‘ cul{n s
& Does anyone in your fa._. o & Confidences_descriptive “ ° 2
& How would you rate yo_. Residual
&5 How would you rate yo... esiduals
& Do you think you have ... Layer 1 of 1 [ Unstandardized
& Check your blood suga... Previous Next [] Standardized
& When you have abnor... Total [[] Adjusted standardized
& When you have abnor...
& When you have sympt... - [ Create APA style table
& I you find out that your ., Noninteger Weights
@ Round cell counts O Round case weights
[C] Display clustered bar charts O Truncate cell counts O Truncate case weights
[1Suppress tables O No adjustments

‘ Paste H Reset HCanceIH Help |

Figure 4.25: Choosing Variables When Conducting Crosstabs
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The results can be seen in Figure 4.26:

In this table, the columns represent the values of the first variable, and the rows
represent the values of the second variable. Cross-tabulations allow us to show the

proportion of cases in subgroups.

Gender: * Confidence_descriptve Crosstabulation

Confidence_descriptve

Insufficient Adequate
Low self- self- self- Good self-
confidences confidences confidences cnfidence Total

Gender:  Men Count 0 2 17 25 44
% of Total 0.0% 2.0% 17.0% 25.0% 44.0%

Women  Count 1 1 17 37 56

% of Total 1.0% 1.0% 17.0% 37.0% 56.0%

Total Count 1 3 34 62 100
% of Total 1.0% 3.0% 34.0% 62.0% 100.0%

Figure 4.26: Results When Conducting Crosstabs
e) Compare Means

Compare means allows a comparison between numerical variables. We click the

tollowing: Analyze -> Compare Means -> Means.

File Edt View Data Iransform Analyze Graphs Utiities Extensions Window Help

H ng g (= e Pouer Analysis z ET “%\@E Q

Meta Analysis

Reports >
Zai ®@ Descriptive Statistics , b3 @aw  &an  Hau
61 40 2 Bayesian Statistics > 4 1 1 ,
62 28 2 Tales > 2 1 1 1
63 48 2 Compare Means > [Means Kl
64 34 2 ; 2
= p 5 General Linear Model > [l Ons-Sample T Test :
= 7 5 Generalized Linear Models > Indapendent-Samples T Test !
Mixed Model >
67 4 2 ixed Models 3 Summary Independent-Samples T Test 2
Correlate >
58 42 1 - 1 Paired-Samples T Test 2
69 57 1 Regression > 5
[ One-Way ANOVA
70 70 1 Loglinear > 1
7 72 1 Neural Networks , [ One-Sample Proportions 1
72 7 2 Classify 5 [El Independent-Samples Proportions 1
L 62 2 Dimension Reduction >  ElPaired-Samples Proportions... 1
74 58 1 5 l ! 1
Scale >
75 56 2 Bl 2 3 1
7 & 2 Nonparametric Tests > ; ; ; :
7 72 1 Forecasting > 4 3 3 4
78 71 2 Sunival > 1 2 1 1
79 79 1 Multiple Response > 1 2 1 1
% 62 1 EZ Missing Value Analysis 4 2 3 1
o1 & 2 Multiple Imputation N ol 2 1 1
82 29 1 E ] 1 El
< Complex Samples >
Data View Variable View & Simulation
_— Quality Contral N

Figure 4.27: Compare Means
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#2 Means: Options x
Statistics: Cell Statistics:
Megion  ~ Mean
Grouped Median Number of Cases

7

\_&Means x Std. Error of Mean Standard Deviation
Sum

Dependent List: Minimum

& Follow advice a. * = & Age (vears) [Q1] Maximum
Range

& Take. yoyr medi... First

& Persist in follow... Bootstrap Last

&> Monitor your blo... Layer 1 of 1 Variance

9 Kurtosis

Understand if y._..

& y Previous Std. Error of Kurtosis

&> Recognize the ... Skewness

&) Persist in monit... Independent List: Std. Error of Skewnessv

& Take actionto a... = 2

& Evaluate if your ... |¢> Confidences Statistics for First Layer

& Persist in carryi__. [J Anova table and eta

&> Confidences_de... v [[] Test for linearity

IR (== ] (e ] [Coner] [ o |

Figure 4.28: Choosing Variables When Conducting Comparison Means

The results are shown in the following table:

Age (years):

confidencesscore Mean M Std. Deviation
2273 59.00 1

31.82 72.00 1

36.36 79.00 1

4773 70.00 1

50.00 67.00 2 7.071
5227 60.50 2 27577
i A 59.00 3 13528
56.82 76.00 1

59.09 45.00 1 .
61.36 66.25 4 5737
63.64 71.50 2 707
65.91 68.00 2 2.828
£8.18 66.50 4 11.328
70.45 66.20 5 14.025
7273 60.20 5 12,677
75.00 65.57 7 11.844
77.27 71.50 8 9.366
79.55 70.29 7 10.515
81.82 74.00 1 .
84.09 54.50 4 9.983
86.36 64.57 7 13.227
88.64 70.00 3 15133
90.91 66.00 5 9.849
93.18 60.67 6 11.361
95.45 68.25 4 4,500

Figure 4.29: Result when Conducting Compare Means
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f) Custom Tables

This is a frequency table that allows comparisons between variables. We click the
tollowing: Analyze -> Tables -> Custome Tables.

File Edit View Data Iwansform Analyze Graphs Utiities Extensions Window Help

E.J g W % Power Analysis > EE E\% ‘\‘Q)E Q

Meta Analysis >
L Repots >
£ & Q2 Descriptive Statistics , bas & Q10 &a & Q4
61 40 2 Bayesian Statistics > 1 1 1 1
62 28 2 Tables > EE Custom Tables... 1 1
: gj i Compare Means ? Muttiple Response Sets : ;
= o = General Linear Model > Diiie Catsigory Osder L :
Generalized Linear Models >
66 79 2 it s El 2 1 1
7 E] 2 e oces 1 2 1 2
68 2 1 Correlate # 1 5 2 2
69 57 1 Regression % 1 2 2 2
70 70 1 Loglinear > El 1 1 1
7 72 1 Neural Networks > A 1 1 1
72 71 2 Classify s El 1 3 1
LE 62 2 Dimension Reduction > 1 2 1 1
74 58 1 3 1 1 1
Scale >
5 56 2 El 2 3 1
= & 3 Nonparametric Tests > 3 3 3 -
77 72 1 Forecasting > Kl 3 3 1
8 71 2 Sunival > 1 2 1 1
79 79 1 Multiple Response > 1 2 1 1
80 62 1 Bl Missing Value Analysis -1 2 3 1
81 o 2 Multiple Imputation > bl 2 : 1
82 29 1 A El A 1
< Complex Samples >
PR \/.iciic View £ Simulation..
Figure 4.30: Custom Tables
8 Custom Tables x
Table Titles Test Statistics Options
Variables: [ Normal 2 Compact Layers
& Prevent higho... i i )
& Follow advice .. «
{ii'm! Confidences_descriptive
Categories Low self.| Insufficient ] Sufficient ] High self-
 Low self Count Count Count Count
H Insufficient self-confi Mien nnnn nnnn nnnn| nnnn|
8 Sufficient self-confide Wormen nnnn| nnnn nnnn| nnnr|
Gender:
i High self-confidence Non-hinary nnnn| nnnn| nnnn| nnnn|
Other: nnnn| nnnn nnnn| nnnn|
2
4
< > o
Define Summary Statistics
Ny Summary Statistics Position Columns v [JHide Category Position:
Default v
88 Categories and Totals Source: Row Variables v -

Figure 4.31: Choosing Variables When Conducting Custom Tables
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The results are shown in Figure 4.32. In the figure, we can see the gender
distribution of diabetes self-care and self-confidence levels.

Custom Tables

Confidence_descriptve

Insufficient Adequate
Low self- self- self- Good self-
confidences confidences confidences cnfidence
Count Count Count Count

Gender.  Men 0 2 17 25
Women 1 1 17 37
Mon-hinary gender 0 0 0 0
Other: 0 0 0 0

Figure 4.32: Results When Conducting Custom Tables

g) Chart Builder

If you want to display the variables in a graph, click the following: Graphs -> Chart
Builder.

@Uébenik_visav [DataSet1] - IBM SPSS Statistics Data Editor
File Edit View Data Transform Analyze Graphs Utilities Extensions Window He

It E%] g W “% % il Chart Buider...

mmma) 1l
‘ Graphboard Template Chooser... —
£ a & & a3 Relationship Map... &a
Weibull Plat..
1 69 2 3.0 Compare Subgroups
2 il 2 =0 Regression Variable Plots
3 59 1 40
T 70 2 30 Legacy Dialogs >
5 43 2 40 1 1 4
6 83 2 20 3 4 3
7 45 2 30 1 1 -1
8 54 1 20 1 1 4
9 46 2 20 3 2 1
10 1 1 3.0 1 1 1
" 54 1 20 1 1 4
12 46 1 3.0 1 3 1
13 67 1 30 3 1 1
14 -1 2 5.0 1 4 1
15 81 2 3.0 3 1 4

Figure 4.33: Chart Builder
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#3 Chart Builder

Variables: Chart preview uses example data Element Properties Chart Appearance Options

2 ro:itor yo:rifblo - Stacked Bar Count of Confidence_deatack; setcalor Edit Properties of

nderstan
) Y Gender. Bar ~ ]

& Recognize the .. X-Axis1 (Barl) ‘
& Persist in monit.... Y-Axis1 (Barl) .
& Take actionto a... - PR

& Evaluate if your .. Statistics
& Persist in carryi... [ 3 Variable:
& confidencesscore §§ ég §% a ég - Statistic:
&> Confidence_des... v 2, 23 28 &2 Count v

eee ] R ELS g 38
3% 23 2@ @

[ Low self-confidence * 2 S Ge Set Parameters
H Insufficient self-conf = D L

Adequate self-confic I Display gror bars
B Adeq v igh  Confidence_descripte | Error Bars Represent
< >

I ® Confid

Gallery Basic Elements Groups/Point ID  Titles/Footnotes

Choose from: o :‘:mq"‘ e
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Bar @ Standard deviatior

Line l.l Multiplier: |2

Area =

Pie/Polar ) ® % ¢ P Bar Style:

Scatter/Dot

N ] (o] B Bar v

Histogram

High-Low

Boxplot

Dual Axes | Stacked Bar

| Paste ‘ ‘ Reset ||Cance||| Help ‘

Figure 4.34: Choosing a Variable for the Chart

Figure 4.35 shows graphically the gender ordering of the level of self-confidence of
patients with diabetes mellitus.

Stacked Bar Count of Confidence_descriptve by Gender:

Gender:
W Men
W 'Women
M Non-binary gender
60 W Other
§ 10
Q
o
20

Low self- Insufficient self-  Adequate self- Good self-
confidences confidences confidences cnfidence

Confidence_descriptve

Figure 4.35: Gender Distribution of Self-Confidence Levels in the Chart
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4.4 Statistical Inference

Statistical inference is the process of concluding populations or scientific truths from
data. There are many modes of performing inference, including statistical modelling,

data-oriented strategies, and explicit use of designs and randomization in analyses.

Statistical tests can also be chosen according to the variables involved in the
hypothesis and their distribution (Fig. 4.36). It should be noted that the following
table represents a simplified visualization of statistical tests that can be used to test

the hypothesis given the constraints of normal or non-normal distribution.

Distribution

Variables Normal (Gaussian) Not normal
2 descriptive Hi-square test (Crosstabs; Chi-square)
1 descriptive and 1 Independent samples t-test Mann-Whitney U Test
numeric (Compare Means; Independent (Nonparametric Tests; Legacy
samples t-test) Dialogs; 2 Independents
Samples)
2 numerical Correlation (Correlate — Biv. — Correlation (Correlate — Biv.
(correlation) Pearson coefficient) Spearman’s coefficient)
2 numetric (average) t-test dependent samples Wilcoxonov test (Nonparametric
(Compare Means; Paired samples | Tests; Legacy Dialogs; 2 Related
t-test) Samples)

Figure 4.36: Choosing a Statistical Test Based on the Distribution
4.5 Performing Independent Samples t-Test in SPSS

If we have one numeric variable and one descriptive variable with two classes and
the distribution is normal, we can use the Independent samples t-test. It is used to
check whether the mean difference between two groups is statistically significant
(Mishra, et al., 2019). To perform the Student t-test we should click the following:
Analyze -> Compare Means -> Independent-Samples t-test (Fig. 4.37).
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File Edit View Data Transform Analyze Graphs Utilities Extensions Window Help

B M e % GQEQ
Hea

Reports >
S & Q2 Descriptive Statistics > bas &aro &an ®au
61 40 2 Bayesian Statistics > 1 1 1 1
62 28 2 Tables > 2 1 1 1
63 48 2 Compare Means > D Means... -1
Z j‘; z Qeneral.Llnea.r Model > [ One-Sample T Test... f
= 79 B Generalized Linear Models > Independent-Samples T Test... ]
67 -1 2 Mixed Models ? Summary Independent-Samples T Test 2
68 42 1 iorrelate. ; ] Paired-Samples T Test... 2
Regression
?3 _5,; 1 Loglinear > E QOne-Way ANOVA... f
71 72 1 Neural Netwarks N One-Sample Proportions... 1
72 7 2 Classify > Independent-Samples Proportions... 1
& 62 2 Dimension Reduction > [l Paired-Samples Proportions... 1
74 58 1 2 1 1 1
75 56 2 Scale ’ -1 2 3 1
76 67 5 Nonparametric Tests > 1 3 1 1
7 72 1 Forecasting > B 3 3 1
78 7 2 Survival b4 1 2 1 1
79 79 1 Multiple Response > 1 2 1 1
80 62 1 Missing Value Analysis. .. -1 2 3 1
£l 87 2 Multiple Imputation > A 2 ! !
82 < ]—2941; Complex Samples > i B i B
B2 Simulation. .. -

Data View Variable View

At Ao <

Figure 4.37: First Step in Choosing Independent Samples t-Test

The numerical variable should be placed in the Test variable box, the ordinal variable
should be placed in the Grouping variable box. We should also define groups, as
presented:

& independent-Samples T Test

@Deﬁne Groups X

Test Variable(s):
& Age (years): [Q1] =l & Confidences
& Education: [Q3]
& Are you employed? [Q4] Y ® Use specified values
&> What is your marital status? [...
&> Does anyone in your family h.. GTULIP l:
&> How would you rate your curr...

&> How would you rate your com.... Grouping Variable: GTDLIP 2:
&> Do you think you have enough...

Q2(? ?
&> Check your blood sugar when 27)

&> When you have abnormal bloo... Define Groups. O Cut point:

&> When you have abnormal bloo...

D Whan i ho rbnme o Estimate effect sizes
Continue [Jie=IIE
ok paste

Figure 4.38: Choosing Variables When Conducting a t-Test

II
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Results are presented in three tables:

Std. Error
Gender: M Mean Sti. Deviation Mean
confidencesscore  Men 51 77.8075 16.93808 2.37180
Waomen 64  81.1080 16.47805 2.05976

Independent Samples Test

ene's Test for Equality of
Variances t-test for Equality of Means
95% Confidence Interval of the
Significance Mean Std. Error Difference
F Sig. t df One-Sidedp  Two- Difference Difference Lower Upper
confidencesscore  Equal variances 251 618 -1.054 113 147 294 -3.30047 313150 -9.50453 29036
assumed
Equal variances not -1.051 106.005 148 296 -3.30047 314135 -9.62849 29275
assumed
Independent Samples Effect Sizes
Point 95% Confidence Interval
Standardizer® Estimate Lower Upper
confidencesscore  Cohen's d 16.68317 -198 -.566 71
Hedges' correction 16.79493 =197 -.562 A70
Glass's delta 16.47805 -.200 -.569 A70

a. The denominator used in estimating the effect sizes.
Cohen's d uses the pooled standard deviation.
Hedges' correction uses the pooled standard deviation, plus a correction factor.
Glass's delta uses the sample standard deviation of the control group.

Figure 4.39: Results When Conducting a t-Test

First, we check for homogeneity of variance. To test for homogeneity of variances,
we will use the results of Levene’s test. If the p-value of Levene’s test is greater than
0.05, it means that there are no differences in variances between the two groups and
we print the results from the top row. A p-value for the Levene’s test of less than
0.05 represents a significant difference between variances. We take the result from

the row below.

Here is an example of how the results are reported: Based on Levene's test for
homogeneity of variances, we found that the assumption of homogeneity of
variances for self-confidence score was appropriate for male and female participants
(p=0.618). The difference in mean self-confidence score between males and females
is not statistically significant (M=-3.300; 95% CI [-9.505; 2.904]; p = 0.294).

4.6 Performing the Kruskal Wallis Test in SPSS

If you have one numeric variable and one descriptive variable with more than two
classes, and the distribution is not normal, choose the Kruskal Wallis test. To
perform the Kruskal Wallis test we should click the following: Anakyze ->
Nonparametric Test -> Legacy Dialogs -> K Independent Samples.
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62 28 2 Tables
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65 40 2 Generalized Linear Models
66 79 2 Mixed Model
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68 42 1 Correlate
69 57 1 Regression
70 70 1 Loglinear
7 72 1 Neural Networks
72 7 2 Classify
B 62 2 Dimension Reduction
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Scale
75 56 2
7% 67 2 Nonparametric Tests
77 72 1 Forecasting
78 7 2 Survival
79 79 1 Multiple Response
80 62 1 EZMissing Value Analysis.
81 87 2
Multiple Imputation
82 29 1 o ’
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3
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Legacy Dialogs > K Related Samples... :
- i -1 -1 -1 Bl A

Figure 4.40: First Step in Choosing Kruskal Wallis Test

The numerical variable should be placed in the Test variable box, the ordinal variable

should be placed in the Grouping variable box. We should also define groups, based

on how many classes are included:

oral Independent Samples

Test Variable List:
& Are you employed? [Q4] & & Confidences
&b What is your marital status? [Q5]
&5 Does anyone in your family hav.
&b How would you rate your comm.
& Do you think you have enough ..
& Check your blood sugar when y.
& When you have abnormal blood...
& When you have abnormal blood...
& When you have symptoms, an... v

Grouping Variable
Q10(? ?)

Test Type
Kruskal-Wallis H [] Median
[[J Jonckheere-Terpstra
OK Paste

@Several Independent Samples... X
Range for Grouping Variable
Minimum:

Maximum:

Figure 4.41: Choosing Variables When Conducting Krusal Wallis Test
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Results are presented in two tables:

Kruskal-Wallis Test

Ranks

How would you rate your

current health? M Mean Rank
Confidences  Very good 12 78.75

Good 67 G64.10

Sufficient 30 36.92

Bad 4 46.75

Wery bad 1 21.00

Total 114

Test Sta\tistit:sa’h

Confidences

Kruskal-Wallis H 20.999
df 4
Asymp. Sig. =001

a. Kruskal Wallis Test

b. Grouping Variable: How
would you rate your
current health?

Figure 4.42: Results When Conducting Krusal Wallis Test

The results can be reported as follows: Based on the Kruskal Wallis Test, we found
that an assessment of the participant's current state of health statistically affects the
self-confidence score (y2 = 20.999; p < 0.001).

4.7 Performing the ANOVA Test in SPSS

If you have one numeric variable and one descriptive variable with more than two
classes, and the distribution is normal, choose the ANOVA test. To perform the
ANOVA test, we should click the following: Analyze -> Compare Means -> One-Way
ANOVA. We can also run a post-hoc test to see which variables are statistically
significantly different.
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Figure 4.43: First Step in Choosing ANOVA Test
Then, we should choose one numerical and one descriptive variable.
#2 One-Way ANOVA x

Dependent List:
& Age (years): [Q1]

B

&5 Gender: [Q2]

&5 Education: [Q3]

&5 Are you employed? [Q4]

&5 What is your marital status? [QA]
&5 Does anyane in your family have
&5 How would you rate your current __.
&5 Do you think you have enough kn..
&> Check your blood sugar when yo...
&5 When you have abnormal blood 5.
&5 When you have abnormal blood 5.
&> When you have symptoms, and ..
&5 If you find out that your blood sug...
&5 If you find out that your blood sug... ~ [[] Estimate effect size for overall tests

- | Paste

Figure 4.44: Choosing Variables When Conducting ANOVA Test

Eactor:

||_£) How would you rate your commitme...”

| Reset | |Cance|| | Help |
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Oneway
ANOVA

Age (years):

Sum of

Squares df Mean Square F Sig.
Eetween Groups G77.959 2 338.980 2124 124
Within Groups 20109.544 126 1559.600
Total 20787.504 128

Figure 4.45: Results When Conducting ANOVA Test

The results can be reported as follows: Based on ANOVA, we found that the test is
not statistically significant (F(2, 126)=338.980; p=0,124).

4.8 Performing the Correlation Test in SPSS

Correlations are used when we are measuring a linear relationship between two
numerical variables. In the case of a normal distribution, we use the Pearson
correlation coefficient, and in the case of an unequal distribution, we use the

Spearman correlation coefficient.

To perform the correlation test we should click the following: Analyze -> Correlate -

> Bivariate:

File Edit View Data Iransfom Analyze Graphs Utiities Extensions Window Help

O, Power Analysis > B al (> O\
e T e~ Bl @
Meta Analysis >
67 : SCODI_C1 5
= _— Reports >
7z & Descriptive Statistics , b &aw  @an  &au
73 62 2 Bayesian Statistics > 4 ) 4 4
7 58 1 Tables > 3 1 1 1
5 56 2 Compare Means > 1 2 3 1
L0 & 2 General Linear Model > 1 3 1 1
77 2 ! Generalized Linear Models > A 3 3 1
& n 2 Mixed Model > ! 2 ! 1
79 79 1 ixed Modsls 1 5 B A
80 62 1 L > [ Bivariate with Confidence Intenvals s
81 87 2 Regression > I Bvariste 1
82 29 1 Loglinear > Epatia 3
83 51 2 Neural Netwark > 1
eural Networks @ Distsnces.
8 L 1 Classify > me P 1
anonical Correlation
% 82 ! Dimension Reduction > 2
86 58 2 1 1 3 1
Scale >
87 63 1 2 2 3 1
88 3 4 Nonparametric Tests > 4 ] ; .
89 74 2 Forecasting > n 2 B ’
90 A 2 Sunival > 2 4 B 1
91 -1 2 Multiple Response > 3 2 1 1
92 63 2 g Missing Value Analysis 1 2 1 2
% &6 2 Muttiple Imputation > 1 - 1 1
9 75 1 3 3 1 1
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Figure 4.46: First Step in Choosing Correlation Test
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Then, we should choose two numerical variables and correlation coefficient:

3 Bivariate Correlations x

&> Monitor your blood sugar as o... ~ & Age (years): [Q1]

&> Understand if your blood suga... ‘y Confid |
&> Recognize the symptoms of I... Bootstrap

& Persist in monitoring your dia... —

& Take action to adjust your blo.... Confidence intenval
& Evaluate if your actions were ...

& Persist in carrying out actions...
& Confidences_descriptive v

Correlation Coefficients
Pearson [ ]Kendall's tau-b [ Spearman

Test of Significance
@ Two-tailed O One-tailed

[V Elag significant correlations  [_] Show only the lower triangle Sho

Figure 4.47: Choosing Variables When Conducting Cotrelation Test
Results are presented in the table (Fig. 4.48):
Correlations

Correlations

Age (years).  Confidences

Age (years): Pearson Correlation 1 -.076
Sig. (2-tailed) 430
I 132 109
Confidences  Fearson Correlation -.076 1
Sig. (2-tailed) 430
M 109 16

Figure 4.48: Results When Conducting Correlation Test

Figure 58 explains the correlation values:

Value Explanation

-1 Perfect linear relationship (negative)

-0.70 Very strong correlation (negative)

-0.40 Medium or moderate correlation (negative)

-0.10 Very high or very strong downward correlation (negative)
0.00 No coherence

+0.10 Low or weak connectedness (positive)

+0.40 Medium or moderate (positive)

+0.70 Very strong correlation (positive)

+1 Full or functional connectivity (positive)

Figure 4.49: Explanation of Correlation Value
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The results can be reported as follows: The Pearson’s correlation test did not show
a correlation between age and self-care confidence score. Age and self-care

confidence scores are not statistically significantly correlated (rs=-0.076; p=0.430).
4.9 Performing the Chi-Square Test in SPSS

To compare two independent descriptive variables, we can use the Chi-square test
and Fishet's exact test. The Chi-square test is applied assuming a large sample size,
while the Fisher exact test is applied to small samples. The Fisher exact test is
generally used for small samples, but can also be used for larger samples (Kim, 2017).

To perform the Chi-square test in the SPSS, we should click the following: Analyze
-> Descriptive Statistics -> Crosstabs

File Edit View Data Transform Analyze Graphs Utilities Extensions Window Help

H {g] w Power Analysis > E‘ = Myg @E Q

Meta Analysis >
67 : SCODI_C1 5
- Reports > E - -
& at & Q2 Descriptive Statistics > Frequencies... ®a & SCO1DI_C
97 60 2 Bayesian Statistics > [ Descriptives... 1 3
L 70 1 Tables > Population Descriptives 1 4
19090 zg 1 Compare Means > 6, Explore. f ;
General Linear Model > @ = -
Crosstabs...
o 59 2 Generalized Linear Models > 1 5
102 84 2 Vixed Model N 3 TURF Analysis 1 3
103 75 2 iued Models [ Ratio 1 3
Correlate > -
104 80 1 = 2 3
105 2 2 Regression > Proportion Confidence Intervals 1 2
106 74 2 Loglinear > [EP-PPlots . 1 3
107 76 1 Neural Networks > [EQQPlts... 2 3
108 52 2 Classify > -1 2 2 2 5
109 43 2 Dimension Reduction > - 2 1 1 5
110 72 2 -1 2 1 1 5
Scale >
M 62 2 h ) -1 3 2 1 5
112 53 P Nonparametric Tests > 1 P 1 1 5
113 74 1 Forecasting > 1 3 1 1 F
114 7 1 Suvival > 1 2 1 1 5
115 68 2 Multiple Response > -1 2 2 1 5
116 a7 1 Missing Value Analysis... 1 2 1 1 4
iy “ 2 Multiple Imputation > 1 2 1 1 5
118 (i1} 2 1 ? 1 1 A
< Complex Samples >
Data View Variable View % Simulation...
_— Ouality Contral >

Figure 4.50: First Step in Choosing Chi-Square Test
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Both variables are ordinal, one should be placed in the Row and the other in the

Column. Then we should click on Statistics to choose the Chi-square test:

R Crosstabs x #38 Crosstabs: Statistics x
Row(s): H
Correlations
& Age (years) [Q1] B & Gender- [Q2] . [ Cor
& Education: [Q3] * Nominal Ordinal
& Are you employed? [Q4] . .
& What is your marital sta Column(s): [ Contingency coefficient  [[] Gamma
& Does anyone in your fa... & Do you think you have ... [ Phi and Cramer's V []Somers' d
& How would you rate your... ‘ Style [JLambda ] Kendall's tau-b
& How would you rate your. Bootstrap. - -
& Check your blood sugar . Layer 10f 1 = [ Uncertainty coefficient [ Kendall's tau¢
& When you have abnorm.. Previous Next
& When you have abnorm... Nominal by Interval [ Kappa
& When you have sympto... Et
Eta Risk
& Ifyou find out that your ... hd o LIR:
& Ifyou find out that your ..., [ McNemar
I Display layer variables in table layers [] Cochran's and Mantel-Haenszel statistics

[ Display clustered bar charts Tact ~rrmman adde rabin armale

[[] Suppress tables

Figure 4.51: Choosing Variables When Conducting Chi-Square Test

Results are presented in tables:

Gender: * Do you think you have enough knowledge about
diabetes self-care and management? Crosstabulation
Do you think you have enough

knowledge about diabetes self-
care and management?

Yes |think| Mo, don't
have think | have
sufficient enough
knowledge knowledge Total

Gender:  Men Count 44 14 58
% of Total 326% 10.4% 43.0%
Women  Count 64 13 7
% of Total 47 4% 9.6% 57.0%
Total Count 108 27 135
% of Total 80.0% 20.0% 100.0%

Chi-Square Tests

Asymptotic
Significance Exact Sig. (2- Exact Sig. (1-
Value df (2-sided) sided) =ided)
Pearson Chi-Square 1.088% 1 297
Continuity Correction® 682 1 409
Likelihood Ratio 1.079 1 .299
Fisher's Exact Test .385 204
Linear-hy-Linear 1.080 1 288
Association
M of Valid Cases 135

a. 0 cells (0.0%) have expected count less than 5 The minimum expected countis 11.60

b. Computed only for a 2x2 table

Figure 4.52: Results When Conducting Chi-Square Test
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The results can be reported as follows: Based on a Chi-square test, there is no static
association between gender and diabetes knowledge (p=0.297).

410  Performing the Mann-Whitney U Test in SPSS

If you have one numeric variable and one descriptive variable with two classes and
the distribution is not normal, use the Mann-Whiteney U test. To perform the Mann-

Whiteney U test, we should click the following: Analyze -> Nounparametric Tests ->
Legacy Dialogs -> 2 Independent Samples.

File Edt View Data Transform Analyze Graphs Utiities Extensions Window Help

fr Power Anal > === e
HE I e rows BE i
Meta Analysis >
67:SCODI_C1 5
Reports >
<
Sa1 & P — , bas & a1 &a & & SCC:DI_C & scozm_c re

97 60 2 Bayesian Statistics > 4 2 1 1 3 3
98 70 1 Tables > El 2 1 1 4 1
2 66/ 1 Compare Means > 1 5 1 2 1 1
100 L 1 General Linear Model > 1 2 1 1 3 3
10 i : Generalized Linear Models > =1 2 1 1 9 2
102 8 2 s N Bl 3 3 1 3 1
103 75 2 ri A 3 1 1 3 1
104 80 1 Corelate 4 1 3 3 2 3 3
105 62 2 Regression ¥ -1 2 1 1 4 3
106 7 2 Loglinear > Bl 3 1 1 3 3
107 76 1 Neural Networks > 1 3 1 2 3 3
108 52 2 Classify 5 A 2 2 [ chi-square.
103 ) 2 Dimension Reduction > il 2 1 [ Binomial
10 72 2 S 5 El 2 1 ] Runs.
11 62 2 b El 2 2
12 5 2 Nonparametric Tests > A One Sample [ 1-Sample K-S
13 7 1 Forecasting > A Independent Samples [ 2 Independent Samples
14 4l 1 Sunival > & Related Samples [ K Independent Samples.
::Z j? f Mutiple Response > 5 Quade Nonparametric ANCOVA [ 2 Related Samples.
L= - : Missing Value Analysis T 5 B K Related Samples

Multiple Imputation >
118 A8 2. 1 2 1 1 & 5

< Complex Samples >

Data View Variable View

B3 Simulation

Qualitv Contral

Figure 4.53: First Step in Choosing Mann-Whiteney U Test

The numerical variable should be placed in the Test variable box, the ordinal variable

should be placed in the Grouping variable box. We should also define groups as

presented:

2 Two-Independent-Samples Tests

& Education: [Q3]
& Are you employ.
& What is your ma.
& Does anyone in

& How would you
& How would you r.
& Check your bloo
& When you have

Test Type
Mann-Whitney U

[ Moses extreme reactions

Test Variable List
= & Confidences

Grouping Variable

Qu(12)
=

[ Kolmogorov-Smimov Z
[ Wald-Wolfowiitz runs

Q Two Independent Samples: De.. X

Group 1:

Group 2:

P ]

| Cancel || Help |

Figure 4.54: Choosing Variables When Conducting Mann-Whiteney U Test
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Results are presented in tables:

NPar Tests
Mann-Whitney Test
Ranks

Do you think you have
enough knowledge about

diabetes self-care and Sum of
management? I Mean Rank Ranks
Confidences  Yes, |think | have 92 63.70 5860.50
sufficient knowledge
Mo, I dont think | have 22 3157 £94.50
enough knowledge
Total 114
Test Statistics”
Confidences
Mann-Whitney LI 441 500
Wilcoxon W 694.500
z -4.105
Asymp. Sig. (2-tailed) <.001

a. Grouping Variable: Do you
think you have enough
knowledge about diabetes
self-care and management?

Figure 4.55: Results When Conducting Mann-Whiteney U Test

The results can be reported as follows: The Mann-Whitney U test showed that there
is a statistical effect of knowledge about diabetes self-care and management on
confidences score (U=441.500; p<0.001).



60

ADVANCED QUANTITATIVE RESEARCH METHODS IN NURSING




lanaa
ADVANCED QLM—\NTITATI\"H RESEARCH METHODS IN NURSING -%-
L. Gosak et al. University of Maribor Press

5 Regression

This chapter introduces the characteristics of regression, with detailed discussions
of linear regression, logistic regression and multiple regression. In addition to the
theoretical background for each type of regression, practical guidance is provided
on how to perform these regression analyses using SPSS software. The learning
objectives of this chapter are to enable the reader to understand the basic concepts
of the different types of regression, including their application and interpretation of

results. The practical part of the chapter will teach the reader how to use SPSS to

petform linear, logistic and multiple regression. This includes preparing the data,

setting up the analyses and interpreting the output. In this way, the chapter will

provide the reader with a comprehensive understanding of the different regression

techniques and how they can be applied in practice.

Regression is a method by which we want to test the relationship between two
numerical variables. We have univariate, bivariate, and multivariate regression
analysis at our disposal. Regression is also distinguished according to the type of
dependent wvariable: regression-numerical (normally distributed) and logistic
regression (the dependent variable has a binomial distribution). Regression can also

be linear or nonlinear (square, cubic, exponential, ...).



62 ADVANCED QUANTITATIVE RESEARCH METHODS IN NURSING

5.1 Linear Regression

Simple (simple, bivariate) linear regression tests the dependence of random variables.
The regression function represents the regression line. The variable being predicted
is called the dependent variable. The variable used to predict the other variable is
called the independent variable. This relationship or model can be written in the

form of an equation:
Y=a+B -X+e

Where Y is the (dependent) variable or outcome studied, X is the (independent)

explanatory variable or predictor, and ¢ is a random variable (error) whose role is:

a) measurement (rounding) errot;

b) another random deviation from the linear relation Y = o + $X.

We can assume E (¢) = 0. On average, then, a linear relation holds. However, we can

also assume that e ~ N (0, o) for some unknown deviation o.

A sample of size n is n pairs of measurements (Xi, Yi). They are obtained by n

replications of a random experiment.

The parameters of the model o and 8 are estimated so that the line Yb = o + X fits
the data as closely as possible.

The regression line (y ') can be written as y' = a + bx. We can draw several regression
lines between the points that will fit these points. It is necessary to determine the
criteria that will determine which line best fits the given points.

The parameter a determines where the regression line intersects the ordinate,a =Y
(0), so Y has the value of a when X has the value 0, b determines the slope of the
line (positive or negative connection and connection strength). b is called the
regression coefficient. It tells how much the value of Y changes if X changes by one
unit. If b = 0, then Y does not depend on X (the variable Y is a constant for which

the value of the variable X has the same value, i.e. Y '= a).
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Most commonly, we use the least-squares method, which requires that the sum of
the squares of the deviations from the regression line be minimal.

Performing regression analysis also includes certain steps: verification of certain
assumptions, verification of the reasonableness of the model, and interpretation of

regression coefficients.

Assumptions for performing linear regression are:

—  Variables must be measured at a continuous level.

—  The variables must be independently observable of each other.

— The residuals (errors) of the best-fitting regression line have a normal
distribution.

— The ratio between X and Y is linear; a linear relationship between the two
variables is expected). To check whether a linear relationship exists can create a
scatterplot that may look like one of the following:

Linear relationship No linear relationship

Figure 5.1: Linear Regression

— Y values are normally distributed around the regression line, and there are

no significant outliers:

Outlier Outlier

Figure 5.2: Outlier Regression
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— The scattering of Y is constant around the regression line, and data show

homoscedasticity:

Heteroscedasticity

— observations are independent.

Heteroscedasticity

Homoscedasticity

Figure 5.3: Heteroscedasticity Regression

Before performing the analysis, the listed assumptions must be verified.

Graphic display

— Spread diagrams are used to show the relationship of two numerical variables.

From the scattering graph, we can understand the pairs drawn as points in the

coordinate system.

— Responsible surfaces.

We estimate the regression constant (a) and the regression coefficient (b) when

interpreting the model.

To judge how good the regression model (regression function) is, we check:

—  Determination coefficient (shate of explained variance) — a quality indicator of

the description of the dependence between the variables with a regression line.

— Standard estimation error - an indicator of the quality of predicting the value of

a dependent variable using a regression line.
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5.2 Steps to Conduct the Linear Regression in SPSS

To perform the linear regression, we should click the following: Analyze -> Regression
-> Linear.

File Edit View Data Transform Analyze Graphs Utilities Extensions Window Help

HE M ey oo CBE i QA
\— Reports >

el | e Descriptiv Statistics » ECESCON RN R
1 69 2 Bayesian Statistics > 4 2 1 1
2 45 2 Tables > 4 3 2 1
3 59 1 Compare Means > -1 1 1 1
g n 2 General Linear Model > 4 2 1 1
2 sl 2 Generalized Linear Models > 4 ! 1 !
6 83 2 Mixed Model R 3 3 3 2
7 4 2 ec Hodels E 2 1 E
8 5 1 Corelate > 4 3 1 2
9 46 2 Regression > [ Automatic Linear Modeling. 1
10 - 1 Loglinear > [gllLinear.. 2
" 54 1 1
Neural Netuworks > [# Curve Estimation..
12 16 1 Classify N 1
13 &7 1 - [ Partial Least Squares.. 1
Dimension Reduction >
14 -1 2 [ Binary Logistic.... 1
15 81 ;S ? 1
Mult | Logistic.
Nonparametric Tests 5 [l Muttinomial Logistic
16 51 2 [ Orginal 1
17 65 2 Forecasting > rdinal... 1
= = - EN— « B Probit... .

Figure 5.4: First Step When Choosing Linear Regression

Transfer the independent variable (e.g., confidences score), into the Independent(s)

box and the dependent variable (e.g., age), into the Dependent box.

3 Linear Regression X
Dependent:
&) Gender: [Q2] Al ™ @ Age (years): [Q1]
& Education: [Q3] Block 1 of 1
&> Are you employed. ..
& What is your marit... Preyious
&> Does anyone in yo... Block 1 of 1
& How would you rat... & Confidences

& How would you rat...

&> Do you think you h..
&> Check your blood ...
&> When you have ab...

&> When you have ab..
&> When you have sy...
& Ifyou find out that .
& Ifyou find out that .. Method:  Enter v
& After taking action... |
& Ifyou find out that ...
& Do you take insuli....

& Ifyou find out that ...
&b Prevent high or low...
& Follow advice abou..

%I:iif?.xotir medicin... ol
‘ Paste H Reset HCance\‘ ‘ Help |

Selection Variable:

Case Labels:

WLS Weight:

Figure 5.5: Choosing Variables When Conducting Linear Regression
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To check the above stated assumptions, the researcher can use the Statistics and

Plots features and then select the appropriate options within these two dialogue
boxes.

Click on the OK button and generate the results.

The first table is the Model Summary table:

Model Summary

Adjusted R Std. Error of
Model R R Square Square the Estimate

1 0767 006 -.003 11.256

a. Predictors: (Constant), Confidences

Figure 5.6: Results (Model Summary) of Linear Regression

This table provides the R and R? values. The R value represents the simple
correlation and is 0.076 (the "R" Column), indicating the variables are untelated. If
R is close to -1 it means that there is a negative correlation between the variables, if
R is close to 0 it means that the variables are uncorrelated, if R is close to 1 it means

that the variables have a positive linear relationship between the two variables.

The R? value (the "R Square" column) indicates how much of the total variation is

in the dependent variable. In this case, 0.6% can be explained as very low.

Normal P-P Plot of Regression Standardized Residual

Dependent Variable: Age (years):

038

06

Y

0.4 ;
&

Expected Cum Prob

02

00 02 04 06 08 1.0

Observed Cum Prob

Figure 5.7: Results of Normal P-P Plot of Regression
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The next table is the ANOVA table, which reports how well the regression equation
fits the data:

ANOVA?
Sum of
Model Squares df Mean Square F Sig.
1 Regression 749.352 1 78.352 626 430°
Residual 13556336 107 126.695
Total 13635688 108

a. Dependent Variable: Age (years):

h. Predictors: (Constant), Confidences

Figure 5.8: Results (ANOVA) of Linear Regression

This table indicates that the regression model predicts the dependent variable
significantly well. How do we know this? Look at the "Regtression" row and go to
the "Sig." column. This value indicates the statistical significance of the regression
model that was run. Here, p = 0.430, indicates that, overall, the regression model

does not statistically significantly predict the outcome variable (i.e., it is not a good
fit for the data).

The Coefficients table provides us with the necessary information to predict total
confidence score from age, as well as determine whether income contributes

statistically significantly to the model (by looking at the "Sig." column):

Coefficients”

Standardized
Unstandardized Coefficients Coefficients

Model B Std. Error Beta t Sig.
1 (Constant) 69.277 5295 13.084 =.001
confidencesscore -.052 065 -.076 -791 430

a. Dependent Variable: Age (years):
Figure 5.9: Results (Coefficients) of Linear Regression

5.3 Logistic Regression

The logistic regression predicts the probability that a variable falls into one of two
dichotomous dependent variable categories based on one or more independent
variables.
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In the logistic regression, the following assumptions must be met:

— The dependent variable must be measured on a dichotomous scale.

— One or more independent variables, which may be continuous, ordinal or

nominal, must be included.

— There must be an independent observation.

—  There must be a linear relationship between all independent variables and a logit
transformation of the dependent variables (Stoltzfus, 2011; Sperandei, 2014).

5.4 Steps to Conduct the Logistic Regression in SPSS

To perform the logistic regression, we use the following function: Analyze ->

Regression -> Binary Logisti.

File Edit View Data Transform Analyze Graphs Utilities

H Ll;l] g ! Power Analysis
1 =y ‘1
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3 54 1 Correlate
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10 -1 1 Loglinear
1 54 1 Neural Networks
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13 67 1 Dimension Reduction
14 -1 2
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16 51 2 Nonparametric Tests
17 65 2 Forecasting
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19 -1 -1 Multiple Response
20 59 2 Missing Value Analysis...
2! 53 ! Multiple Imputation
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Figure 5.10: First Step When Choosing Logistic Regression

In our case, we have a dependent variable, “Enough knowledge about diabetes self-
care and management”, with two categories, “yes, I think I have sufficient

knowledge” and “no, I don't think I have enough knowledge’, and five independent

Extensions

>

Window Help

b a9 & Q10 & an
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WN W s N s W N
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variables, gender, employment status, assessment of current health status, family
history of diabetes, level of self-confidences. We use the "Enter" method that is
commonly used for standard regression analysis (Fig. 5.11). You can choose from
the following methods: Enter, Forward: Conditional, Forward: LR, Forward: Wald,
Backward: Conditional, Backward: LR, Backward: Wald. The differences between
the methods are in how they add or remove variables from the model. The enter
method includes all predictor variables simultaneously without selection. In forward
methods, the algorithm starts with an empty model and gradually adds predictors
one by one until no more significant improvement is observed. Backward methods
start with a full model including all possible predictors and gradually remove

predictors one by one until no significant improvement is observed.

@Logistic Regression X

& Age (years): [Q1] * - &% Do you think you have enou...
Ve .
& Gender: [Q2] Block 1 of 1 =4
& Education: [Q3] —
Previous Mext

&5 Are you employ...
&5 What is your m... Block 1 of 1 -
&5 Does anyone in... Q2 ~

&5 How would you ... Q4
&5 How would you .. Q10
&5 Check your blo_..

=a*b= Q9
gWhen you have ... [Confidences_descriptive | v
When you have __.
&5 When you have ... Method: Enter v

% :;you :nj ou: :: Selection Variable:

ou find out th_ .

Y . . - Rule
&5 After taking acti..

- oW
‘ Paste H Reset HC:—mceI‘ ‘ Help ‘

Figure 5.11: Choosing Variables When Conducting Logistic Regression

Next table contains the Cox & Snell R Squared and Nagelkerke R Squared values,
which are both methods for calculating a variation (Fig. 5.12). The variance of the
dependent variable in our model ranges from 22.1% to 32.4%.
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Omnibus Tests of Model Coefficients

Chi-square df Sig.
Step1  Step 14.483 5 013
Block 14.483 5 013
Model 14.483 5 013

Model Summary

-2 Log Cox &SnellR Magelkerke R
Step likelinood Square Square
1 51.824° 221 324

a. Estimation terminated at iteration number &
because parameter estimates changed by less
than .001.

Figure 5.12: Results (Model Summary) of Logistic Regression

The logistic regression estimates the probability that an event will happen, so in our
case, whether a person will have enough knowledge about diabetes self-care and

management.

Table index states, "The cut value is 0.500". This means that if the probability of a
case being classified as "yes" is greater than 0.500, then that case is classified as "yes".

Otherwise, the case is classified as "no" (as mentioned eatrlier).

In our case, the model classified the 39 people who thought they had sufficient
knowledge about diabetes self-care and management into the appropriate group. It
classified four people into the group with insufficient knowledge. When classifying
persons with enough knowledge about diabetes self-care and management, the
accuracy was 90.7%. 10 people who did not have enough knowledge were
inappropriately classified as having enough knowledge. Five people were
appropriately classified as not having enough knowledge. The model accuracy value

was 33.3%. The overall model correctness was 75.9%.
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Classification Table®
Predicted
Do you think you have enough
knowledge about diabetes self-
care and management?

‘Yes, I think | Mo, Idont
have think | have
sufficient enough Percentage
Observed knowledge knowledge Correct
Step 1 Do you think you have Yes, | think | have 38 4 a0.7
enough knowledge about  sufficient knowledge
ﬂzﬁite:njjg;gare g No, | don'tthink | have 10 5 333
Tl enough knowledge
Overall Percentage 75.9

a. The cutvalue is 500

Figure 5.13: Results (Classification Table) of Logistic Regression

Figure 5.14 shows the contribution of each independent variable to the model and
its statistical significance.
The Wald test (column " Wald ") is used to determine the statistical significance for

each of the independent variables. In our case, none of the variables are statistically

significant.
Variables in the Equation
B S.E. Wald df Sig. Exp(B)

Step1®  Gender: 877 737 846 1 358 1.969
Are you employed? 063 404 025 1 875 1.065
Does anyone in your -126 261 233 1 629 R
family have a diagnosis
of diabetes?
How would you rate your 621 527 1.392 1 238 1.861
current health?
Confidence_descriptve -1.551 713 4733 1 .030 212
Constant 1.881 3317 322 1 871 6.561

a.Variable(s) entered on step 1: Gender:;, Are you employed?, Does anyone in your family have a
diagnosis of diabetes?, How would you rate your current health?, Confidence_descriptve.

Figure 5.14: Results (Variables in the Equation) of Logistic Regression
5.5 Multiple Regression

We speak of a multiple regression when a random variable depends on more than
one explanatory variable. The variable we want to predict is called the dependent
variable; the variables we are using to predict the value of the dependent variable are

called the independent variables.
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The multiple regression also allows you to determine the overall fit (variance
explained) of the model and the relative contribution of each of the predictors to

the total variance explained.

Assumptions for performing multiple regression are:

— The dependent variable should be measured on a continuous scale (i.e., it is

either an interval or ratio variable).

— Two or more independent variables must be included, which can be either
continuous (i.e., an interval or ratio variable) or categorical (i.e., an ordinal or

nominal variable).

—  There should be independence of observations (i.e., independence of residuals),

which we can easily check using the Durbin-Watson statistic.
— There needs to be a linear relationship between:
— () the dependent variable and each of your independent variables,
— (b) the dependent variable and the independent variables collectively.

— Data needs to show homoscedasticity, which is where the variances along the

line of best fit remain similar as you move along the line.

—  Data must not show multicollinearity, which occurs when you have two or more

independent variables that are highly correlated with each other.

— There should be no significant outliers, high leverage points, or highly influential

points.

— We need to check that the residuals (errors) are approximately normally

distributed (we explain these terms in our enhanced multiple regression guide).
5.6 Steps to Conduct the Multiple Regression in SPSS

Click Analyze -> Regression -> Linear.
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12 46 1 Classify 4 . !
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Dimension Reduction >
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16 51 2 " 1
F fin , [ ordinal
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2 o3 ! Muttiple Imputation > [ 2-Stage Least Squares... 1
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< Complex Samples > B Quantile
Data View Variable View B Simulation [ Optimal Scaling (CATREG)...

Figure 5.15: First Step When Choosing Multiple Regression

Transfer the dependent variable (i.e., Confidences score) into the Dependent: box
and the independent variables (i.e., age, gender, education, family history of
diagnosed disease, marital status, assessment of current health status, sufficient
knowledge of diabetes self-care and management) into the Independent(s): box:

#3 Linear Regression x

-~

& Age (years): [Q1] g & Confidences

& Gender: [Q2] Block 1 of 1

&> Education: [Q3]

&5 Are you employed. .. UL

&5 What is your marit_. Block 1 of 1

& Does anyone in yo_.. & Age (years): [Q1] -
&5 How would you rat._. & Gender: [Q2)]

&> How would you rat... &> Education: [Q3]

&b Do you think you h... &5 Does anyane in your family...

&b Check your blood .. &5 What is your marital status...

&5 When you have ab... & How would you rate your c...

ﬁWhen you have ab... [&- Do vou think you have eno.__ |~
When you have sy._..

&b Ifyou find out that . Method:  Enter v

&b Ifyou find out that .
&5 After taking action. ..
&b Ifyou find out that _..

Selection Variable:

L3 Rule

Figure 5.16: Choosing Variables When Performing Multiple Regression
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Click on the LR T button:

@Linear Regression: Statistics X

Regression Coefficie... Model fit

[IR squared change

[] Confidence intevals [ ] Descriptives

[] Part and partial correlations

[[] Coyariance matrix [] Collinearity diagnostics
Residuals
] Durbin-Watson

[[] Casewise diagnostics

®
0]

[ELIGIEE | Cance

Figure 5.17: Statistics Options When Performing Multiple Regression (1)

In addition to the options that are selected by default, select Confidence intervals in
the —Regtession Coefficients— area, leaving the Level (%): option at "95":

tﬂ! Linear Regression: Statistics X

Regression Coefficie..  [/] Model fit
Estimates

[C]R squared change

opfidence intervals ] Descriptives

Level(%): [J Part and partial correlations

[] Covariance matrix  [_] Collinearity diagnostics

Residuals

[] Durbin-Watson
[] Casewise diagnostics

®
@]

Figure 5.18: Statistics Options When Performing Multiple Regression (2)

Click on the button. You will be returned to the Linear Regression dialogue box.
Click on the button. This will generate the output.
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The first table is the Model Summary table. This table provides the R, R2,
adjusted R2, and the standard error of the estimate, which can be used to determine

how well a regression model fits the data:

Model Summary

Adjusted R Std. Error of
Model R R Square Square the Estimate

1 7257 525 463 13.58999

a. Predictors: (Constant), Do you think you have enough
knowledge about diabetes self-care and management?,
Whatis your marital status?, Education;, Does anyone in
your family have a diagnosis of diabetes?, Gender:, Age
(years): , How would you rate your current health?

Figure 5.19: Results (Model Summary) of Multiple Regression

The "R" column represents the value ofR, the multiple correlation
coefficient. R can be considered to be one measure of the quality of the prediction
of the dependent variable, in this case, the confidence score. A value of 0.725, in this
example, indicates a middle level of prediction. The "R Square" column represents
the R2 value (also called the coefficient of determination), which is the proportion
of variance in the dependent variable that can be explained by the independent
variables (technically, it is the proportion of variation accounted for by the regression
model above and beyond the mean model). You can see from our value of 0.525
that our independent variables explain 52.5% of the variability of our dependent

variable, the confidence score.

The F-ratio in the ANOVA table (Fig. 5.20) tests whether the overall regression
model is a good fit for the data. The table shows that the independent variables
statistically significantly predict the dependent variable, F (7, 53) = 8.381, p<0.001.

ANOVA?
Sum of
Model Squares df Mean Square F Sig
1 Regression 8954810 7 1279.259 8.381 <001°
Residual 8089.628 53 152.634
Total 17044.438 60

a. Dependent Variable: confidencesscore

h. Predictors: (Constant), Do you think you have enough knowledge about diabetes
self-care and management?, What is your marital status?, Education:, Does anyone
in your family have a diagnosis of diabetes?, Gender:, Age (years):, How would you
rate your current health?

Figure 5.20: Results (ANOVA) of Multiple Regression



76 ADVANCED QUANTITATIVE RESEARCH METHODS IN NURSING

The general form of the equation to predict blood sugar from age, gender,

education, family history of the diagnosed disease, marital status, assessment of

current health status, and sufficient knowledge of diabetes self-care and management

is:

— predicted confidences score = 111.437 + (0.067 x age) + (3.614 x gender) +
(0.155 x education) + (0.124 x family history of diabetes) + (1.166 x marital
status) - (7.878 x assessment of health status) - (20.753 x knowledge)

This is obtained from the Coefficients table (Fig. 5.21):

Coefficients?

Standardized
Unstandardized Coefficients Coefficients

Model =] Std. Error Beta t Sig.

1 (Constant) 111.437 14.396 7.741 =.001
Age (years): (067 160 .045 419 677
Gender: 3614 3416 108 1.058 .295
Education: 155 1.164 .014 133 .894
Does anyone in your 124 1.242 .010 100 9
family have a diagnosis
of diahetes?

What is your marital 1.166 1.620 074 720 475
status?

How would you rate your -7.878 2.452 -.353 -3.213 .002
current health?

Do you think you have -20.753 4612 -.494 -4.500 =.001

enough knowledge about
diabetes self-care and
management?

a. Dependent Variahle: confidencesscore

Figure 5.21: Results (Coefficients) of Multiple Regression

Unstandardized coefficients indicate how much the dependent variable varies with
an independent variable when all other independent variables are held constant.
Consider the effect of age in this example. The unstandardized coefficient, B1,
for age, is equal to 0.067 (see Coefficients table). This means that for each one-year

increase in age, there is a decrease in confidence score of 0.067.

You can test for the statistical significance of each of the independent vatiables. This
tests whether the unstandardized (or standardized) coefficients are equal to 0 (zero)
in the population. If p<0.05, you can conclude that the coefficients are statistically
significantly different to O (zero). The t-value and corresponding p-value are in the

"t" and "Sig." columns.
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6 Questionnaire Validation

The chapter covers the steps of back translating a questionnaire, developing the
questionnaire and validating the questionnaire. It also presents w of assessing
the reliability and validity of a questionnaire. The learning objectives of this chapter
are to enable the reader to understand the whole process of questionnaire
development, including back-translation techniques to ensure the linguistic and
cultural appropriateness of the questionnaire. The reader will be introduced to the
key steps in questionnaire design, such as determining the content, structure and
format of the questions. In addition, the chapter will introduce the reader to

validation methods, which include checking that the questionnaire measures what

it is intended to measure. An important part of the chapter will also present ways

of assessing the reliability and validity of the questionnaire.

6.1 Questionnaire Translation

Back-translation is necessaty for the use of the questionnaire in the local
environment. The original questionnaire should be translated into the target
language by at least two independent translators. It is recommended that both
translators are native speakers of the target language. This step is followed by a back-
translation. The translated questionnaire should be translated back into the source
language by a second independent translator. The re-translated questionnaire in the

original language is checked against the original questionnaire to identify any
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discrepancies. This step is crucial to ensure an accurate translation of the
questionnaire (Tyupa, 2011; Behr, 2017).

6.2 Questionnaire Development

Steps in the process of questionnaire development (T'sang, et al., 2017):

— Identify the dimensionality of the construct.

— Determine the format in which the questionnaire will be administered.
—  Determine the item format.

— Item development.

—  Determine the intended length of the questionnaire.

— Review and revise the initial pool of items.

—  Preliminary pilot testing.

FORWARD
TRANSLATION EXPERT COMMITTE

-

—_——————

o@c

BACKWARD PRELIMINARY PILOT
TRANSLATION - TESTING

4

Figure 6.1: Questionnaire Translation Steps
6.3  Reliability vs. Validity

Reliability is the extent to which the outcomes are consistent when the experiment
is repeated more than once (Watson, 2015).

Internal consistency reflects the extent to which the questionnaire items are
intercorrelated or whether they are consistent in measuring the same construct.
Internal consistency is commonly estimated using the coefficient alpha - known as

Cronbach's alpha.
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Cronbach's alpha ranges from 0 to 1 (when some items are negatively correlated
with other items in the questionnaire, it is possible to have negative values of
Cronbach's alpha).

6.4 Test-Retest Reliability

Test-retest reliability refers to the extent to which individuals’ responses to the
questionnaire items remain relatively consistent across repeated administration of
the same questionnaire or alternate questionnaire forms. The correlation between
the two questionnaires’ responses can be referred to as the coefficient of stability. A
larger stability coefficient indicates stronger test-retest reliability, reflecting that
measurement error of the questionnaire is less likely to be attributable to changes in

the individuals’ responses over time (Yen & Lo, 2002).
6.5 Inter-Rater Reliability

For questionnaires in which multiple raters complete the same instrument for each
examinee (e.g., a checklist of behaviour/symptoms), the extent to which raters are
consistent in their observations across the same group of examinees can be
evaluated. This consistency is referred to as inter-rater reliability or inter-rater
agreement. Validity is the extent to which the instruments that are used in the
experiment measure exactly what you want them to measure. The validity of a
questionnaire is determined by analysing whether the questionnaire measures what

it is intended to measure (Hallgren, 2012).
6.6 Content Validity

Content validity refers to the extent to which the items in a questionnaire are
representative of the entire theoretical construct the questionnaire is designed to
assess. The experts judge whether the questionnaire items are adequately measuring
the construct intended to assess and whether the items are sufficient to measure the
domain of interest. Several approaches to quantify the judgment of content validity
across experts are also available, such as the content validity ratio and content

validation form.
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The questions were clear and easy

The questions covered all the
problem areas with you

You would like the use of this
questionnaire for future assessment

The questionnaire lacks important
questions regarding your

Some of the questions violate
your privacy

Figure 6.2: Example Items to Assess Content Validity

Figure 6.3 shows the division of CVI (content validity) into CVI for a single index
and CVI for the whole scale (Polit, et al., 2007).

CvI
Content validity

£ 2

v
S-CVi[Ave

Average of the I-CVI scores for all
items on the scale

S-CVIJUA
The proportion of items on the
scale that achieve a relevance scale
of 3 or 4 by all experts.

Figure 6.3: Content Validity Index

For the content checks, we prepare a content assessment form (Fig. 6.4) for the

team of experts who will carry out the review. It is recommended to use the
evaluation form (Fig. 6.5).
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The selection of experts for the review is based on the individual's knowledge and
expertise on the topic. Researchers recommend that the number of content

reviewers should be at least six and no more than ten (Yusoft, 2019).

Dear Experts,

We will assess participants’ self-care using the validated Self-Care of Diabetas Inventory (SCODI) (Ausili, et al,,
2017).

We kindly ask you to rate each statement for content relevance on a 4-point scale:

» 1-content/statement not relevant/not understandable/not relevant;
s 2-content / claim is poorly understood [ very deficient / incomplete [ partially relevant;
s 3-content / claim is partizlly understandable [ partially relevant;

* 4 -the content / claim is fully understandable / fully relevant.

Please complete the table by placing an X under the selected rating and entering any comments, advice,

opinions on the content and translation in the "Coemments” column.

Figure 6.4: Example of Guidance for Assessing the Relevance of Questions for Content
Validation by Experts

sCoDIC

Listed below are some of the behaviours a person with diabetes can do to help improve blood sugar levels
when they are too high or too low. Participants are asked to identify how often they do {or would do) these
actions when symptoms occur or when blood sugar is out of range (rated on a Likert scale from 1 to 5, where 1
represents never and 5 represents always; question 29 asks for a yes or no answer)?

1 2 3 4 Comments

Check your blood sugar when you feel symptoms
1. | (such as thirst, frequent urination, weakness, | O | O | O | O
perspiration, anxiety)?

When you have abnormal blood sugar levels, do
2. | you take notes about the events thatcould have | O | O | O | O
caused it and actions you took?

When you have abnormal blood sugar levels, do
you ask a family member or friend for advice?
When you have symptoms, and you discover that
4. | your blood sugar is low, do you eat or drink | O | O | O | O
something with sugar to solve the problem?

If you find out that your blood sugar is high, do
you adjust your diet to fix it?

If you find out that your blood sugar is high, do
you adjust your physical activity to fix it?

After taking actions to adjust an abnormal blood
7. | sugar level, do you re-check your blood sugarto | O | O | O | O
assess if the actions you took were effective?

If you find out that your blood sugar is very low
8. | or very high, do you call your health care | O | O | O | O
provider for advice?
9. | Do you take insulin? o|jo|jofog
If you find out that your blood sugar is too high
10.| or too low, do you adjust your insulin dosage in | O | O | O [ O
the way your health care provider suggested?

Figure 6.5: Example of a Form for Assessing the Relevance of Content by Experts
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The results are then used to calculate I-CVI (item content validity index), S-
CV1/Ave (scale-level content validity index based on the average method) and S-
CVI/AU (scale-level content validity index based on the universal agreement
method).

We scored 1 if the experts rated the items 3 (partially relevant) or 4 (fully relevant)
and 0 if the experts rated them 1 (not relevant) or 2 (partially relevant).

Experts agree: represents the sum of all experts who agreed, i.e., gave a rating of 3
or 4. In our example, 5 experts agreed on Q1 (1+1+1+1+1+1+0=5)

I-CVI: Percentage of content experts who rated the relevance of the element as 3
or 4. In our case, I-CVI for Q21 is calculated as 5 divided by 6 experts and is 0.83.

Formula: I-CVI = (number of items rated 3 or 4)/(number of experts)

General agreement (UA): We score 1 for those questions where all experts agree. In
our case, such questions were Q4, Q5, Q7 and Q9.

S-CVI/Ave: The average of the I-CVI scores for all items on the scale, or the
average of the proportion of importance scored by all experts. The relevance score

is the average of the relevance scores given by each expert.

Formula: S-CVI/Ave = (sum of I-CVT scores)/(number of items);

S-CVI/Ave = (sum of relative importance ratings)/(number of experts)
S-CVI/UA: the proportion of items in the scale that achieve a relevance score of 3
or 4 across all experts. The universal agreement (UA) score is given as 1 if the item

achieved 100% expert agreement. Otherwise, the UA score is given as 0.

Formula: S-CVI/UA = (sum of UA scores)/(number of items) (Yusoff, 2019).
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No. Question(s) Expert1 | Expert2 | Expert3 | Expert4 | ExpertS | Expert6 Expertin |y oyy | ya

L. |Check your blaod sugar when you feel symptoms (suchasthirst. | | 1 L 1 L o
frequent urination, eakness, perspiration, anxiety)?

. |When you have abnormal blood sugar levels, do you take notes 1 1 1 B 1 o
about the events that could have caused it and actions you took?

5. |Whenyou have abnormal blood sugar levels, do you aska family | | 1 L 1 L L
member or friend for advice?
When you have symptoms, and you discover that your blood

4. |sugaris low, do you eat or drink something with sugar to solve 1 1 1 1 1 0
the problem?

5. |Myoufind out that your blood sugar is high, do you adjust your 1 1 1 1 ! o
diet to fix it?

6. |Mfyou find out that your blood sugar is high, do you adjust your 1 1 i ; 1 i
physical activity to fix it?
After taking actions to adjust an abnormal blood sugar level, do

7. |vou re-checkyour blood sugar to assess if the actions you took 1 1 1 1 1 0
were effective?

5. |[fyoufind out that your blood sugar is very low or very high. do 1 1 B B L B
you call your health care provider for advice?

9. | Do you take insulin? 1 1 1 1 1 0
Tf you find out that your blood sugar is too high ar too low, da you

10. |adjust your insulin dosage in the way your health care provider 1 1 1 1 1 0

Proportion relevance

S-CVIjAve

S-CVIjuA

6.7

[ scvi/Ave (based on

Figure 6.6: Calculation of I-CVI and S-CVI

Construct Validity

Construct validity is the most important concept in evaluating a questionnaire that

is designed to measure a construct that is not directly observable (e.g., pain, quality

of recovery). If a questionnaire lacks construct validity, it will be difficult to interpret

results from the questionnaire, and inferences cannot be drawn from questionnaire

responses to a behaviour domain. The construct validity of a questionnaire can be

evaluated by estimating its association with other variables (or measures of a

construct) with which it should be correlated positively, negatively, or not at all
(Smith, 2005; Bhandari, 2022).

Criterion

validity

Discriminant Convergent Concurrent

validity validity

validity

Predictive
validity

Content
validity

Figure 6.7: Construct Validity Process
Source: (Warren, et al., 2018)

Face validity
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7 Reliability Analysis

The chapter introduces reliability analysis, including intraclass cortelation
coefficient (ICC) and Cronbach's alpha, and the practical implementation of these
analyses in SPSS software. The learning objectives of this chapter are to enable the
reader to understand the key concepts and methods for assessing the reliability of
survey questionnaires. The reader will learn how to use ICC to measure inter-rater

reliability and Cronbach's alpha to assess the internal consistency of a questionnaire.

The chapter also provides practical guidance on how to perform these analyses in
SPSS.

The following sections consider, in turn: inter-rater reliability, test-retest reliability,
and intra-rater reliability. These methods are all based on correlation between sets
of measurement, and the test of choice for each is selected from one of a range of
forms on intraclass correlations (ICCs) (Koo & Li, 2016). These have replaced other
measures of reliability based on correlation, such as Pearson’s r and the Kappa
statistic, which were previously used. The reason that ICCs are preferred is that, as
opposed to these other tests of correlation is that ICCs measure both the correlation
between two sets of measurement (raters or ratings) and measure the degree of
agreement between the two sets of measurement.

There are 10 different forms of ICC, but in the following, we will consider only the
three that are most common and required to test these forms of reliability rigorously.
ICCs are described in terms of ‘model’, ‘type’ and ‘definition’. These depend,
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respectively, on whether we are: 1. dealing with the same raters between ratings or a
random sample of raters; 2. are we using the mean value of several raters or values
from single raters; and 3. are we interested in consistency between raters or absolute
agreement. For an excellent and detailed consideration of ICCs, consult Koo and Li
(2016). As a rule of thumb, we are normally concerned with single-rater
measurements. Where different raters are involved in rating the same phenomenon
(inter-rater reliability), it is sufficient to look at consistency between measurements,
but where the same raters are involved (test-retest reliability and intra-rater

reliability), then we need to look at absolute agreement between ratings.

1CCs are normally expressed with 95% confidence intervals, and values, which lie

between 0 — 1, are conventionally interpreted as follows:

Value Explanation
<0.05 Poor
0.05-0.75 Moderate
0.75-0.90 Good

>0.90 Excellent

Figure 7.1: Cronbach Alpha Value and Reliability Level

7.1 Intraclass Correlations

Click Analyze > Scale > Reliability analysis, as shown in Figure 7.2:

File Edt View Data Transform Analyze Graphs Uiiies Extensions Window Help

B S g W~ - Power Analysis > EmeEm Al ()
. M= g y 04 D
Meta Analysis , BB e
Reports >
sai & a2 Descriptive Statistics , bao & a1 &an &au o Scr):]Lc
1 69 2 Bayesian Statistics > 4 2 1 1 4
2 45 2 Tables > 4 3 2 1 5
3 59 1 Compare Means > -1 1 1 1 5
& L 2 General Linear Model > 4 2 1 1 3
£ i 2 Generalized Linear Models > 4 1 1 L 3
6 &3 2flf| == 3 3 3 2 3
>
7 45 2 B 4 2 1 4 3
8 54 1| Comelate > 4 3 1 2 3
9 46 2 Regression > : s . : :
10 El 1 Loglinear > 1 2 4 2 3
" 54 1 Neural Networks > 4 3 1 1 5
12 46 1 Classify > 1 2 1 1 3
> U 1 Dimension Reduction > 1 2 2 1 3
4 | 2 . - B . 5
15 81 2 Scale > [ZReliability Analysis 5
= = 5 Nonparametri Tests > | [ Weighted Kappa =
17 65 2 Forecasting > & Muttidimensional Unfolding (PREFSCAL). 3
Sunival >
i 64 2 =i [ Multidimensional Scaling (PROXSCAL). 5
19 4 £ Multiple Response > e 5
= = 2 Mutidimensional Scaling (ALSCAL) :

Missing Value Analysis

Figure 7.2: First Step When Conducting Reliability Level
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Transfer the selected variables. Leave the model Alpha, as this is the command to

run Cronbach's Alpha. Select the options highlighted in Figure 7.3.

& Age (years): [Q1]

& Gender [Q2)]

& Education: [Q3]

& Are you employed? [Q4]

& What is your marital status? [Q5]

& Does anyone in your family hav. .

&) How would you rate your current. ..
&5 How would you rate your commi...
& Do you think you have enough k...

ftems:

& Check your blood sugar when y...
& When you have abnarmal blood ...
& When you have abnarmal blood .-

& When you have symptoms, and..

& IF you find out that your blood su -
& If you find out that your blood su -
& After taking actions to adjust an..

Ratings-

#3 Reliability Analysis: Statistics

Descriptives for
Mitem

[ Scale

[ Scale ifitem deleted

Summaries

[ Means

[ Variances
[ Covariances
[ Correlations

Interrater Agreement. Fleiss' Kappa

[m]

PiCorelations

[ Covariances

ANOVA Table
@ None
O Etest
O Friedman chi-square

O Cochran chi-square

& Check your blood sugar when y...
& When you have abnormal bload -
& When you have abnormal bload
& When you have symptoms, and.__
& Ifyou find out that your blood su___
& Ifyou find out that your blood su___
& After taking actions to adjust an...
& If you find out that your blood su...

Missing

® Exclude both user-missing and system missing values

© User-missing values are treated as valid
[]Hotelling's T-square [ Tukey's test of additiity

[Jintraclass correlation coefficient

8 Mim com sbem immeitins KOO o0
Model- Alpha v
Scale label:

Figure 7.3: Choosing Variables When Performing Reliability Analysis

The first table of results presents the reliability, which is shown by the actual value
for Cronbach's alpha. For our questionnaire, the Cronbach alpha is 0.780, which
represents good reliability.

Reliability Statistics

Cronbach's
Alpha Based
on
Cronbach's Standardized
Alpha lterns M of ltems
T80 694 10

Figure 7.4: Reliability Statistic Analysis (Cronbach’s Alpha)

The most important column in the table is "Cronbach's Alpha if Item Deleted". This
column represents the value of Cronbach's alpha if this item were to be deleted (Fig.
7.5).
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Item-Total Statistics

Scale Corrected Squared Cronbach's
Scale Mean if “ariance if Item-Total Multiple Alphaif ltem
ltem Deleted Item Deleted Correlation Correlation Deleted
Check your blood sugar Az 32,760 575 617 747

when you feel symptoms
(such as thirst, frequent
urination, weakness,
perspiration, anxiety)?

‘When you have abnormal 31.73 30101 634 616 734
blood sugar levels, do

you take notes about the

events that could have

caused it and actions you

took?

‘When you have abnormal 32.50 33.989 281 272 780
blood sugar levels, do

you ask a family memhber

or friend for advice?

‘When you have 3093 31.020 19 616 738
symptoms, and you

discover that your blood

sugaris low, do you eat

or drink something with

sugar to solve the

prablem?

If you find out that your 3MAT 31.295 [B8E 696 732
blood sugar is high, do

you adjust your diet to fix

it?

It you find out that your 31.59 32.799 543 634 750
blood sugar is high, do

you adjust your physical

activity to fix it?

After taking actions to an.ae 30110 844 a14 713
adjust an abnormal blood

sugar level, do you re-

checl your hlood sugar fo

assess ifthe actions you

took were effective?

ITyou find out that your 33.44 30.702 -.051 348 .B26
blood sugar is very low or

very high, do you call your

health care provider for

advice?
Do you take insulin? 3434 42,730 -.697 774 .B10
Ifyou find out that your 3085 30.698 617 a18 738

blood sugar is too high or
too low, do you adjust
your insulin dosage in the
way your health care
provider suggested?

Figure 7.5: Item-Total Statistics (“Cronbach’s Alpha if Item Deleted”)
7.2 Inter-Rater Reliability

For questionnaires in which multiple raters complete the same instrument for each
examinee (e.g., a checklist of behaviour/symptoms), the extent to which raters are
consistent in their observations across the same group of examinees can be
evaluated. This consistency is referred to as inter-rater reliability or inter-rater
agreement. Normally, we are concerned with being able to extrapolate our results to

the general population from a randomly selected group of raters, and the appropriate
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form of ICC to test this is a Two-way random effects model with consistency based
on single raters. If we were only specifically interested in the particular group of

raters participating in our study, we would use a mixed-effects model.

Click Analyze > Scale > Reliability analysis, as shown in Figure 7.6:

R rater.sav [DataSet2] - IBM SPSS Statistics Data Editor

File Edit View Data Transform Analyze Graphs Utilities Extensions Window Help

g = ;uyerAnalyéls ? E@ \ﬂl‘%] ‘Cé) III Q
eta Analysis >
|7 Reports 4

&> Rater1 @ Rater2 Descrptive Statistics , Rater6 var var var var var
1 4.00 4.00 2.00
. - N

2 4.00 3.00 Bayesian Statistics 1.00

3 3.00 4.00 Tables > 3.00

4 4.00 4.00 Compare Means 4 2.00

5 4.00 4.00 General Linear Model > 2.00

6 4.00 3.00 Generalized Linear Models > 3.00

7 3.00 4.00 Mixed Models > 2.00

8 4.00 4.00 Correlate N 3.00

9 4.00 4.00 N . N 1.00

10 4.00 3o Sedressen 200

1 4.00 3o leglinear > 200

12 4.00 4.00 Neural Networks > 2.00

13 4.00 4.00 Classify > 3.00

14 4.00 4.00 Dimension Reduction > 2.00
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Figure 7.6: First Step When Conducting Reliability Level

ER Reliability Analysis: Statistics x
Descriptives for Inter-tem
Ottem [ Correlations
[ Scale [ Covariances

[ Seale ifitem deleted

aReliabilty Analyss « Summaries ANOVA Table
[JMeans @© None
[ Variances OEtest
& Ratert Oc O Fried hi
& Rator2 ovariances fiedman chi-square
& Rater3 [ Correlations O Cochran chi-square
& Raterd.
& Raters Interrater Agreement: Fleiss’ Kappa
& Raters ]
[m}
Ratings:
Missing
® Exclude both user-missing and system missing values
O User-missing values are treated as valid
[ Tukey's test of additivity
Type: Consist v
Model Alpha v Vee: EHE Y
Scale label Test valge: D

Figure 7.7: Reliability Analysis: Statistics
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Figure 7.8 shows the results of the reliability analysis.

Reliability Statistics
Cronbach's
Alpha® N of ltems

-.184 6

a. Thevalue is
negative dueto a
negative average
covariance among
items. This violates
reliability model
assumptions. You
may wantto check

item codings.
Intraclass Correlation Coefficient
Intraclass 95% Confidence Interval F Testwith True Value 0
Corrslation” Lower Bound  Upper Bound Value dft df2 Sig
Single Measures -.027? -100 122 844 20 100 655
Average Measures -184° -1.189 454 844 20 100 655

Two-way mixed effects model where people effects are random and measures effects are fixed
a. The estimator is the same, whether the interaction effect is present or not

b. Type C intraclass correlation coefficients using a consistency definition. The between-measure variance is
excluded from the denominator variance.

¢. This estimate is computed assuming the interaction effectis absent, because itis not estimable otherwise.

Figure 7.8: Results of the Reliability Analysis

7.3 Test-Retest Reliability

Test-retest reliability refers to how individuals’ responses to the questionnaire items
remain relatively consistent across repeated administration of the same questionnaire
or alternate questionnaire forms. The appropriate form of ICC to use here is a Two-

way mixed effects model with absolute agreement based on single raters.

ratersav [Dataset2] - 1BM SPSS Statistics Data Editor
Elle Edt View Data TIransform Analyze Graphs Utiities Extensions Window Help

P Power Analysis > 2R L) Q
HE @ v~ = 1Q
Meta Analysis >
22 Rater
Repotts >
Ratert & Rater2 Osscipiin Sistisics , Raterd ar ar ar ar ar
1 4.00 400 200
>
> N Jgo  Baesian Statistcs o
3 300 4.00 Tables # 3.00
4 400 400 Compare Means > 200
5 4.00 400 General Linear Model > 200
6 4.00 3.00 Generalized Linear Models > 3.00
7 3.00 4.00 Mixed Models > 200
8 400 [0 [y , 300
9 400 a0 o . 1w
10 400 3pol | | (Eegreesn 200
1" 400 3.00 Lagiinear > 200
1 100 400 Neural Networks » 2
13 400 400 Classiy > 300
14 400 400 Dimension Reduction > 200
:: : :: : :z Scale > [ZReliabiity Analysis.
Monparametric Tests > i
17 400 s [ weghted Kappa
18 400 400 orecasting [ Myltidimensional Unfolding (PREFSCAL)
>
19 400 4.00 Sunival [ Multidimensional Scaling (PROXSCAL)
Mutiple Response >
2 4.00 4.00 htcle Respos Multidimensional Scaling (ALSCAL)
2 4.00 400 [l Missing Value Analysis. =

2 Multina Immadatinn N

Figure 7.9: First Step When Conducting the Test-Retest Reliability
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#R Reliability Analysis: Statistics x
Descriptives for Inter-ltem
O ltem [ Correlations
[] Scale [] Covariances

[ Scale if item deleted

Summaries ANOVA Table
[] Means @ None
[ Variances O E test
[ Covariances O Friedman chi-sguare
ER Reliability Analysis x [ Correlations O Cochran chi-square
tems .
a2 Statistics. Interrater Agreement: Fleiss’ Kappa
P S g PP
& Rater2 & Rater2 D splay agreement or dual categories
& Rater3 &5 Rater3 (] o
& Raterd | | & Raterd S
& Raters. & Raters,
& Rater6 & Rater6. R
Ratings Missing
® Exclude both user-missing and system missing values
O User-missing values are treated as valid
[ Hotelling's T-square [ Tukey's test of additivity

Intraclass correlation coefficient

Model: Two-Way Mixed v Type: Absolute Agreement v |

Model Alpha v
- e Confidence interval: m %  Testvalue: D
Scale label

Figure 7.10: Test-Retest Reliability
Figure 7.11 shows the results of the test-retest reliability analysis.

Reliability Statistics

Cronbach's
Alpha® N of Items

-.184 6

a. Thevalue is
negative due to a
negative average
covariance among
items. This violates
reliability model
assumptions. You
may wantto check

item codings.
Intraclass Correlation Coefficient
Intraclass 95% Confidence Interval F Testwith True Value 0
Correlation® | yer Bound UpperBound ~ Value dft df2 Sig
Single Measures -.009° -.035 .050 844 20 100 655
Average Measures -.060° -.255 .240 844 20 100 655

Twao-way mixed effects model where people effects are random and measures effects are fixed.
a. The estimator is the same, whether the interaction effectis present or not.
b. Type Aintraclass correlation coefficients using an absolute agreement definition.
¢. This estimate is computed assuming the interaction effectis ahsent, hecause it is not estimable otherwise.

Figure 7.11: Result of the Test-Retest Reliability
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7.4 Intra-Rater Reliability

Intra-rate reliability refers to the extent to which individuals rate the same
phenomenon and remain relatively consistent across repeated ratings. As with test-
retest reliability, the appropriate form of ICC to use here is a Two-way mixed effects

model with absolute agreement based on single raters.

3 “Untitled1 [DataSet0] - IBM SPSS Statistics Data Editor

File Edit View Data Iransform Analyze Graphs Utiities Extensions Window Help
e

HE Mo e 5 AQEQ

Meta Analysis >
10:
- Reports >
& Confident2 ¢ Confi R — 5 var ar var ar ar ar
1 7727
3 Bayesian Statistics >
3 Tables >
71 Compare Means >
5 93.18 General Linear Model >
6 79.55 Generalized Linear Models >
7 Mixed Models >
: Comelate >
>
T = Bagtesslun
= = Loglinear >
12 7045 Neural Networks >
13 6136 Classify >
14 7273 Dimension Reduction >
:2 2; :Z Scale > [Z]Reliability Analysis...
o = Nonparametric Tests : [ Weighted Kappa.
18 100.00 Forecasting [E3 Multidimensional Unfolding (PREFSCAL)...
Sunival >
19 =y 7 Multidimensional Scaling (PROXSCAL)
Muttiple Response >
20 21 ol g Muttidimensional Scaling (ALSCAL).
21 100.00 [ Missing Value Analysis...
22 90.91 Multiple Imputation >

Figure 7.12: First Step When Conducting the Intra-Rater Reliability

T Reliability Analysis: Statistics x
Descriptives for Inter-item
Oitem [ Correlations
[JScale [ Covariances

[Scale if item deleted

Summaries ANOVA Table
R Reliability Analysis x
[ Means ® None
ltems: [ Variances OF test
g C“"ﬁ:m"‘i ggm"m"f [ Covariances O Friedman chi-square
A E— Corelations O Cochran chi-square
qf
Interrater Agreement: Fleiss’ Kappa
[ Displa
W ignore s
]
Ratings
Missing
@ Exclude both user-missing and system missing values
O User-missing values are treated as valid
[JHotelling's T-square [ Tukey's test of additivity
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Confidence interval: [o5 %  Testvalye
Scate e L]

[eee]

Figure 7.13: Intra-Rater Reliability
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Case Processing Summary

M %
Cases Valid 116 82.3
Excluded?® 25 17.7
Total 141 100.0

a. Listwise deletion based on all
variables in the procedure.

Reliability Statistics

Cronbach's
Alpha M ofltems
1.000 2
Intraclass Correlation Coefficient
Intraclass Y 95% Confidence Interval F Testwith True Value 0
Correlation Lower Bound  UpperBound  Value df1 df2 Si
Single Measures 9577 .o 99 . 115
Average Measures g78° 042 996 . 115

Twao-way mixed effects model where people effects are random and measures effects are fixed.
a. The estimator is the same, whether the interaction effect is present or not.
b. Type Aintraclass correlation coefficients using an absolute agreement definition.

c. This estimate is computed assuming the interaction effect is absent, because itis not estimable otherwise.

Figure 7.14: Result of the Intra-Rater Reliability
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8 Factor Analysis

This chapter introduces factor analysis, including a detailed explanation of the basic
concepts, the steps to perform principal component analysis (PCA) in SPSS
software, and the interpretation of the results. The learning objectives of this

chapter are to enable the reader to understand the concepts and methods associated

with factor analysis, particularly PCA. The reader will learn about the purpose and

usefulness of factor analysis in exploring data and will gain practical skills in

petrforming PCA in SPSS and interpreting the results.

Factor analysis aims to reduce the dimensionality of the original space and to give
an interpretation of the new space, which includes a reduced number of new
dimensions that are supposed to be the basis for the old ones (Rietvel & van Hout,
1993, p. 254). It is used in areas such as medicine and nursing, economics,
behavioural and social sciences, and geography (Yong & Pearce, 2013). Different
methods of factor analysis are presented in Figure 8.1.
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Exploratory Factor
Analysis (EFA)

Common Factor
Analysis (CFA)

Principal Component
Analysis (PCA)

General Linear
Models (GLM)
Image Factoring
Maximum Likelihood

Factor Loading

Factor Score

Eigen Values

Rotation Method

%0 00 o

Figure 8.1: Types of Factor Analyses

There are a few methods to verify the adequacy of factor analysis (Nakazawa, 2011):

—  criteria for the adequacy of the sample size,

— Kaiser-Meyer-Olkin (KMO) sampling adequacy criteria, which test whether a
large number of factors exist in a data set,

—  Bartlett’s sphericity test, which tests the hypothesis that the correlations between

the variables are greater than would be accidentally expected.

Commonly used analysis is Principal Components Analysis (PCA). It is a
multivariate data reduction technique that aims to find a new set of variables that is
equal in number to the original set of variables, with these synthetic variables not

related (Rossiter, 2017). PCA is used to extract maximum variance from the data set
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with each component to reduce a large number of variables into a smaller number

of their weighted sums (components). PCA is conceptually different from factor

analysis but is often used synonymously in practice.

PCA can be used for different purposes:

If we have a large number of variables (questions/statements in a questionnaire)
and we believe that some of the variables measure the same
phenomenon/construct; if we find a high correlation between the variables, we
can include only those variables that best represent the construct, and remove
the rest.

This method can be used when we want to create a new
questionnaire/measurement scale, but we are not sure that all the variables
(questions/statements) we have included in our tool measure the same
construct. This way, we can make sure that the variables we have included are
sufficiently representative or that we need to remove them.

In the case where we want to include as few variables (questions/statements) as

possible in an existing questionnaire/measurement scale to shorten it.

To carry out a PCA, the following assumptions must be met:

8.1

Our data must include several variables that must be measured continuously

(ordinal variables are often used).

There must be a linear relationship between all variables.

A sufficiently large sample size is needed to ensure the reliability of the results
obtained. As a general rule, a minimum of 150 cases is recommended, or 5 to
10 cases per variable.

The data must be suitable for data reduction, meaning there must be an adequate

correlation between the variables for them to be reduced.

There must be no significant outliers in the variables.

Steps to Conduct PCA in SPSS

We eliminate n components and decide on a number. Criteria (by relevance):

1. substantive meaningfulness,
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2. scree plot,
3. Desired eigenvalue> 1.

If more than one component is eliminated, as a rule, we rotate - repeat the analysis
with the appropriate number of eliminated components.

Orthogonal rotations (e.g., Varimax): uncorrelated components, fewer inappropriate
solutions.

Oblique-angle rotations (e.g., direct oblimin): a simpler interpretation. If the

correlations between the components are low (e.g., <0.1), we prefer to use Varimax.

We interpret the rotated components in terms of content ("what variables with high

absolute saturations" have in common).

We calculate component achievements if desired:

— Descriptives: Univariate descriptives, correlations, reproduced correlations,

etc.

— Important: At least some correlations should be at least medium-high.

— Extraction: The process of extracting components.

— Method: Principal components.

— Extract: The number of components extracted (in the non-rotated solution
anyway - you can start n).

— Display: Scree-plot (number of "large" components).

— Analyse: If variables with a higher variance are to have a greater effect on the
results, we analyse the covariance matrix (usually for item analysis), otherwise
correlatively (usually for test analysis).

— Rotation: Rotation selection.

— Loading plot: Draws a pattern and not correlations (structure) when rotating
it at an angle.

— Scores: Save as variables: calculating people's achievements.

— Display factor score coefficient matrix: displays weights for calculating

components .

In the following text, the process of conducting PCA in SPSS is presented in figures.
To perform the PCA we should click the following: Click Analyze -> Dimension
Reduction -> Factor.



8 Factor Analysis

99
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<
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Transform ~ Analyze

H® O e~
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Meta Analysis
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Descriptive Statistics
Bayesian Statistics
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Compare Means
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Figure 8.2: First Step when Choosing PCA

Select the variables and specify the appropriate settings, as shown in Figure 8.3.

ﬁi actor Analysis

Variables:

&> Prevent high or .. &
&> Follow advice a._

&> Take your medi...
& Persist in follow..
&> Monitor your blo...
&5 Understand if ...

&> Recognize the ... v/

& Age (years): [Q1]
& Gender: [Q2]

& Education: [Q3]

&> Are you employ...
&> What is your m.__.
&> Does anyone in....
&> How would you ...
&> How would you ...
&> Do you think yo...
&> Check your blo...
&> When you have .. v

Value...

Rotation
Scores_

Options

Selection Variable:

-| Paste l l Reset ||Cance||| Help l

&3 Factor Analysis: Extraction

Method: Principal components

Analyze Display
@® Correlation matrix Unrotated factor solution
O Coyariance matrix [J Scree plot

Extract

@© Based on Eigenvalue

Eigenvalues greater than

O Fixed number of factors
Factors to extract

Maximum Iterations for Convergence

X @ Factor Analysis: Rotation

Extraction...

X
Q Factor Analysis: Descriptives

Statistics

nivariate descriptives

nitial solution

Correlation Matrix

oefficients

[ inverse
Significance levels [ ] Reproduced
[] Determinant [] Anti-image
MO and Bartlett's test of sphericity;

Inue

#3 Factor Analysis: Options

Method Missing Values
O None O Quartimax O Exclude cases listwise
® Varimax O Equamax ® Exclude cases pairwise

O Direct Oblimin - O Promax

D

Display

Rotated solution [] Loading plot(s)

for Ci

O Replace with mean

Coefficient Display Format

Sorted by size

[V] Suppress small coefficients

Absolute value below:

1ce:

g

Figure 8.3: Choosing the Right FA Method
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This table shows two tests that indicate the suitability of the data for FA
implementation. Kaiser-Meyer-Olkin is a statistic that shows the proportion of
variance in variables that can be caused by underlying factors. High values (close to
1.0) generally indicate that FA is beneficial. If the value is less than 0.50, FA results
are unlikely to be useful. Bartlett's test of sphericity tests the hypothesis that variables
are unrelated and, therefore, unsuitable for FA. Small values (less than 0.05) of

significance level indicate that FA is beneficial.

KMO and Bartlett's Test

Kaiser-Meyer-Olkin Measure of Sampling Adequacy. 880
Banlet_t'g Test of Approx. Chi-Square 855620
Sphericity df 55

Sig. =.001

Figure 8.4: KMO and Bartlett’s Test

Eigenvalue presents the quality of the result; a higher result means higher quality.

Total Variance Explained

Initial Eigenvalues Extraction Sums of Squared Loadings Rotation Sums of Squared Loadings
Component Total % of Variance  Cumulative % Total % ofvariance  Cumulative % Total % of Variance  Cumulative %
1 6.337 57.612 57.612 6.337 57612 57.612 4102 37.285 37.285
2 1.033 §.386 66.999 1.033 9.386 66.999 3.267 28.704 66.339
H 811 7.373 74372
4 626 5.688 80.060
& 545 4.951 85.010
6 401 3.643 88.654
7 361 3.285 91.939
8 .205 2.682 94.621
9 272 2.471 97.092
10 A75 1.595 98.686
11 144 1.314 100.000

Extraction Method: Principal Component Analysis

Figure 8.5: Table of Components and Eigenvalues



8 Factor Analysis 101

Correlation Matrix

Take your Evaluate If

medicines in your actions Persistin
the Persistin Menitor yeur Takeactionte  wers effective  carrying out

Preventhigh  Followadvice  appropriate  followingthe  blood sugar  Understandif  Recognize Persist in adjustyour to change actions to
or low blood about way treatment asofienas  yourblood the monitoring  blood sugar  yourblood  improve your
sugarlevels  nutriionand  (ncluding plan =ven yourhealth  sugarlevels  symptomsof  yourdiabstes  and relisve sugarand  biood sugar
nd its physical insulin it whenits  carsprovidsr  are good or lowhlood  svenwhenit your relisve your | evanwhen it

symptorns, actity. presciibed) diffcult asked youto not sugar s diffcult symptoms. symptoms. s diffeult.

Comelation  Prevent high or low blood 1.000 648 416 507 a1 455 423 481 558 684 559
sugar levels and its
symptoms.

Follow advice about 648 1.000 402 534 383 345 428 503 563 640 605
nutrition and physical
activity

Take your medicines in 416 402 1.000 502 362 428 u7 479 431 439 384
the appropriate way

(including insutin if

prescribed).

Persistin following the 507 534 502 1.000 381 301 452 640 527 633 626
treatment plan susn when
it's difficult

Manitor your blood sugar 32 383 382 381 1.000 641 43 571 569 480 473
as often as your health

care provider asked you

[

Understand if your blood 455 345 428 301 641 1.000 525 601 585 450 470
sugar evels are good or
not

Recognizs the symptoms 423 428 347 452 413 525 1.000 814 708 502 499
of low blood sugar.

Persistin monitoring your 481 503 479 640 571 601 614 1.000 730 620 635
diabetes sven when it's
difficutt

Take action to adjust your 558 563 434 527 569 585 708 730 1.000 736 736
blood sugar and relizve
your symptoms.

Evaluate if your actions 684 640 439 633 480 150 592 620 736 1.000 a4
Wars effsctive lo changs

your blood sugar and

relieve your symptoms.

Persist in carrying out 559 605 384 626 473 470 439 635 736 734 1.000
actions to improve your

blood sugar even when it

s difficult

Sig. (1-tailed)  Prevant high or low blood <001 <001 <001 <001 <001 <001 <001 <001 <001 <00t
sugarlevels and its
symptoms.

Follow advice about 000 000 000 000 000 000 000 000 000 000
nutiition and physical
activity.

Take your medicines in 000 000 000 000 000 000 000 000 000 000
the appropriate way

(including insulin if

prescribed)

Persistin following the 000 000 000 000 000 000 000 000 000 000
treatment plan even when
its difficut

Monitar your blood sugar 000 000 000 000 000 000 000 000 000 000
as often as your health

care provider asked you

to

Undarstand ifyour blood 000 000 000 000 000 000 000 000 000 000
sugarlevels are good or
not

Recognize the symptoms 000 000 000 000 000 000 000 000 000 000
of low blood sugar.

Persistin monitoring your 000 000 000 000 000 000 000 000 000 000
diabetes sven when its
difficuft

Take action to adjustyour 000 000 000 000 000 000 000 000 000 000
blood sugar and relisve

your symptoms.

Evaluate if your actions 000 000 000 000 000 000 000 000 000 000
were effective to change

your biood sugar and

religve your symptoms.

Persistin camying out 000 000 000 000 000 000 000 000 000 000

actions to improve your

blood sugar even when it

s difficult

Figure 8.6: Item Correlations

Utilities can range from 0 to 1. Higher values mean that a larger proportion of the
variance of a particular variable can be explained by other variables. These are more
reliable (Fig. 8.7).
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Communalities

Initial Extraction

Prevent high or low blood 1.000 661
sugar levels and its
symptoms.

Follow advice about 1.000 GBE
nutrition and physical
activity.

Take your medicines in 1.000 386
the appropriate way

(including insulin if

prescribed).

Fersistin following the 1.000 628
treatment plan even when
it's difficult.

Monitor your blood sugar 1.000 700
as often as your health

care provider asked you

to.

Understand if your hlood 1.000 44
sugar levels are good or
not.

Recognize the symptoms 1.000 BET
of low hlood sugar.

Fersistin monitoring your 1.000 726
diabetes even when it's
difficult.

Take action to adjust your 1.000 BT
blood sugar and relieve
Your symptoms.

Evaluate if your actions 1.000 792
were effective to change

your blood sugar and

relieve your symptoms.

Persistin carrying out 1.000 q12
actions to improve your

blood sugar even when it’

s difficult.

Extraction Method: Principal Component Analysis.

Figure 8.7: The Utility Matrix

The rotated component matrix tells us which variables are most strongly associated

with each component.
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Rotated Component Matrix®

Component

1 2

Follow advice about 810
nutrition and physical
activity.

Evaluate if your actions BD2 387
were effective to change

your blood sugar and

relieve your symptoms.

Prevent high or low blood 788
sugar levels and its
symptoms.

Persistin carrying out 738 409
actions to improve your

hlood sugar even when it'

g difficult.

Persist in following the ik 307
treatment plan even when
it's difficult.

Take your medicings in RDB 359
the appropriate way

fincluding insulin if

prescribed).

Understand if your blood Bay
sugar levels are good or
not.

Monitor your blood sugar B18
as often as your health

care provider asked you

to.

Persist in monitoring your 508 684
diabetes even when it's
difficult.

Take action to adjust your 583 654
hlood sugar and relieve
your symptoms.

Recognize the symptoms 4B 628
of low blood sugar.

Extraction Method: Principal Component Analysis.
Rotation Method: Varimax with Kaiser
Mormalization.

a. Rotation converged in 3 iterations.

Figure 8.8: Component and Rotated Component Matrix
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